## Contents

**About This Guide** 6  
Safety Alert Conventions 6  
Safety Data Sheets 7  

**Chapter 1: System Overview** 8  
Advantages of Using Labeled Probes with RT-qPCR 8  
Advantages of RT-qPCR TaqMan® Chemistry 9  
Advantages of Using Intercalating Dyes with RT-qPCR 10  
Advantages of Delta Gene™ Chemistry 10  
**Biomark Systems for Genetic Analysis** 11  
High-End Detection Optics 11  
**Biomark System Components** 11  
Controllers for IFCs 12  
Juno 12  
IFC Controllers 12  
Integrated Fluidic Circuit (IFC) Components 13  
**Biomark System Workflow** 15  
Before You Begin 15  
Organizing Your Work 15  
Preventing Contamination 16  
Handling Nucleic Acid, PCR Mixes, and PCR Reactions 16  
Using Controls 16  
What You Need for Experiments 17  
**Supported Detection Reagents** 17  
Probe Types 17  
Additional Probe Types 17  
**PCR Master Mixes** 18  
Sample Requirements 18  
RNA Quality 18  
cDNA Preparation 18  
cDNA Input 18  
cDNA Storage 18  
Reagent Storage 18  

**Chapter 2: Using Real-Time PCR Analysis Software** 19  
Launching the Software 19  
Menus and Icons 20  
Top Menu Bar 20  
Secondary Menu Bar 20  
File 20  
Edit 21  
View 22  
Report 22  
Tools 24  
Biomark Image Viewer Tool Bar 24  
Customizing the Analysis Parameters 26  
Creating a New Chip Run 27  
Opening an Existing Chip Run 28  
Finding Corners Manually (if required) 29  
Forced Manual Corner Find 31  
Setting Up and Annotating a Sample Plate 32  
Using the Sample Mapping Viewer 37  
Using the Replay Control 38  
Using the Dispense Map Editor 39  
Setting Up and Annotating a Detector (Assay) Plate 42  
Advanced User Options 47  
Converting a Chip Run to a More Samples Run 47  
Importing Multiple Chip Runs 49  

**Chapter 3: Viewing Chip Run Data in the Data Analysis Software** 52  
Working with Analysis Settings 52  
Changing the Quality Threshold 52  
Changing the Baseline Correction 53  
Changing the Ct Threshold Method 54  
Working with Details Views 56  
Using the Results Table 56  
Adding User Defined Comments 67  
Using the Image View 68  
Image View Tool Bar 70  
Adjusting the Size of the Location Reference Map 72  
Fused Image View 74  
Using the Heat Map 75  
Layout View 88  
Inlet-Based View 88  
Chip-Based View 88  
Custom View 89  
Using the Graph View 91  
Graph Viewer Tool Bar 91
Toggling the Threshold 92
Using the Graph Edit Button 92
Toggle Edit 92
Toggle Log Graph 92
Changing Pass/Flag 93
Using the Animate Feature 94
Selecting a Single Cell 96
Selecting More Than One Cell 97
Cross Highlighting and Selecting 98

Using Show Dual Views 99
Export IFC Run Data 100
Opening Exported Data (.csv files) 102
Calculating Delta Ct Sample Values 104
Calculating Delta Ct Detector Values 107
Delta-Delta Ct Values 109
Viewing Delta Ct Data in the Heat Map 109

Chapter 4: Viewing Chip Run Data in the Calibration Curve View 111
Introduction 111
CCVM Page Example 112
Using CCVM to Determine Concentration Levels of Unknown Samples 113
Viewing Multiple Calibration Curves 117

Chapter 5: qPCR + Melting Curve Analysis 118
Introduction to qPCR + MCA Chip Runs 118
Running a Chip with a qPCR + MCA Protocol 118
The Tm Ranges 119
Viewing the Tm Ranges 119
Editing the Tm Ranges 119
Working with Views 120
Results Table View 120
Heat Map View 120
Graph View 120
The Melting Graph 121
Exporting Data 122

Appendix A: cDNA Preparation with Reverse Transcription Master Mix 123
Prepare RT Reactions 123
Thermal-Cycle 124

Appendix B: Fast Gene Expression Analysis Using EvaGreen on Biomark or Biomark HD 125
Materials 126
Required Reagents 126
Required Consumables 126
Required Equipment 127
Software Requirements 127

Gene Expression PreAmp with Fluidigm PreAmp Master Mix and Delta Gene Assays 128
Pooling the Delta Gene Assays 128
Preparing Sample Pre-Mix and Samples 128
Thermal Cycling 129

Exonuclease I Treatment to Remove Unincorporated Primers 129
Preparing Sample Pre-Mix and Samples 130
Preparing the Assay Mix 131

Priming the IFC and Loading Assay and Samples 131
Load the IFC 133
Thermal-Cycle and Collect Real-Time PCR Data 134

Using the Real-Time PCR Analysis Parameters 135
Thermal Cycler Protocols 135
Fast Protocols 135
Standard Protocols 135

Appendix C: Two-Step Single-Cell Gene Expression Using EvaGreen Supermix on the Biomark and Biomark HD Systems 137
Materials 138
Required Reagents 138
Required Consumables 138
Required Equipment 139
Software Requirements 139

Preparing the Reverse Transcription (RT) Reaction Assembly 139
Denaturation of RNA 140
RT Cycling 141
Preparing 10X STA Primer Mix 141
Preparing STA Reaction Mix 142
STA Cycling 142
Exonuclease I (Exo I) Treatment Method 142
Preparing the Sample Pre-Mix and Samples 143
About This Guide

This user guide describes how to use the Real-Time PCR Analysis software using real-time PCR data collected on the Biomark™ HD, Biomark, or EP1™ system. For detailed instructions on instrument operation, see the Juno™ System User Guide (100-7070), IFC Controller MX and IFC Controller HX User Guide (68000112), or IFC Controller RX User Guide (100-3385) and the Biomark HD Data Collection User Guide (100-2451) or Biomark/EP1 Data Collection User Guide (68000127).

IMPORTANT Before using the instrument, read and understand the safety guidelines in this document. Failure to follow these guidelines may result in undesirable effects, injury to personnel, and/or damage to the instrument or to property.

Safety Alert Conventions

CAUTION ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard types specified in procedures may be abbreviated in this document. For complete safety information, see Appendix H.

Fluidigm documentation uses specific conventions for presenting information that may require your attention. Refer to the following safety alert conventions.

Safety Alerts for Chemicals

For hazards associated with chemicals, this document follows the United Nations Globally Harmonized System of Classification and Labelling of Chemicals (GHS) and uses indicators that include a pictogram and a signal word that indicates the severity level:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="example" alt="Pictogram" /></td>
<td>Pictogram (see example) consisting of a symbol on a white background within a red diamond-shaped frame. Refer to the individual safety data sheet (SDS) for the applicable pictograms and hazards pertaining to the chemicals being used.</td>
</tr>
<tr>
<td><strong>DANGER</strong></td>
<td>Signal word that indicates more severe hazards.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Signal word that indicates less severe hazards.</td>
</tr>
</tbody>
</table>
Safety Alerts for Instruments

For hazards associated with instruments, this document uses indicators that include a pictogram and signal words that indicate the severity level:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="example" alt="Pictogram" /></td>
<td>Pictogram (see example) consisting of a symbol on a white background within a black triangle-shaped frame. Refer to the instrument user guide for the applicable pictograms and hazards pertaining to instrument usage.</td>
</tr>
<tr>
<td><strong>DANGER</strong></td>
<td>Signal word that indicates an imminent hazard that will result in severe injury or death if not avoided.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Signal word that indicates a potentially hazardous situation that could result in serious injury or death if not avoided.</td>
</tr>
<tr>
<td><strong>CAUTION</strong></td>
<td>Signal word that indicates a potentially hazardous situation that could result in minor or moderate personal injury if not avoided.</td>
</tr>
<tr>
<td><strong>IMPORTANT</strong></td>
<td>Signal word that indicates information necessary for proper use of products or successful outcome of experiments.</td>
</tr>
</tbody>
</table>

Safety Data Sheets

Read and understand the SDSs before handling chemicals. To obtain SDSs for chemicals ordered from Fluidigm, either alone or as part of this system, go to fluidigm.com/sds and search for the SDS using either the product name or the part number.

Some chemicals referred to in this user guide may not have been provided with your system. Obtain the SDSs for chemicals provided by other manufacturers from those manufacturers.
Chapter 1: System Overview

With Real-Time quantitative PCR (RT-qPCR), accumulation of amplicons in the PCR reaction is measured during the initial part of the reaction (Exponential phase), when reaction components are plentiful. Measurements in this phase are more accurate and reproducible than those taken when amplification begins to slow from the total consumption of some of the reaction components (Linear phase) or when no more amplicons are being generated, at the end point of the reaction (Plateau phase).

Gene expression studies use RT-qPCR to amplify specific messenger RNA (mRNA) regions with oligonucleotides (oligos) and probes or with intercalating dyes. Millions of copies of targeted regions of complementary DNA (cDNA) are produced by reverse transcription from the mRNA template. At each PCR thermal cycle, the probes or dyes quantify the detection of specific mRNA regions.

Advantages of Using Labeled Probes with RT-qPCR

In addition to typical PCR primers, the use of a fluorescently labeled probe (for example, TaqMan®) to anneal to a specific sequence in the PCR amplicon provides highly accurate quantification. Each probe can be designed with a unique fluorophore. Although this can increase assay costs and take time, the specificity permits multiplex reactions and minimizes inaccurate quantification due to no-template control (NTC) amplification.
Advantages of RT-qPCR TaqMan® Chemistry

The Biomark™ Systems use dual-labeled probes, such as TaqMan® probes, for real-time qPCR amplification.

Dual-labeled probes are oligonucleotides that contain a fluorescent reporter dye on the 5’ base, and a quencher located on the 3’ base. When irradiated, the excited fluorescent reporter dye transfers energy to the nearby quencher molecule rather than fluorescing, resulting in a non-fluorescent substrate. Dual-labeled probes are designed to hybridize to a complementary region of the cDNA. The probe is flanked by an upstream and downstream primer pair that generates a PCR product. During PCR, when the polymerase extends the PCR product from the upstream primer, the 5’ exonuclease activity of the polymerase cleaves the probe. This separates the fluorescent quencher and reporter dyes and Fluorescence Resonance Energy Transfer (FRET) no longer occurs. The increase in fluorescence intensity is proportional to the number of probe molecules that are cleaved.

TaqMan Protocols

Appendices D and E describe two fluorescently labeled TaqMan protocols for use on the Biomark HD system:

**Fast gene expression analysis method with probes.** It uses TaqMan with either 48.48 or 96.96 Dynamic Array™ IFCs. See Appendix D: Fast Gene Expression Analysis Using TaqMan Gene Expression Assays on the Biomark HD System for more information.

**Single-cell gene expression analysis method with probes.** It involves single cell sorting, reverse transcription, and specific target amplification (RT-STA), and uses TaqMan with either 48.48 or 96.96 Dynamic Array IFCs. See Appendix E: Single-Cell Fast TaqMan Gene Expression Real-Time PCR Using Dynamic Array IFCs on Biomark HD for more information.
Advantages of Using Intercalating Dyes with RT-qPCR

The use of intercalating dyes for detection (for example EvaGreen® or SYBR® Green) is cost effective because they require only the addition of unlabeled PCR primers. With this method, any dsDNA produced in the reaction is detectable, including amplifications with off-targets and NTCs, which can result in inaccurate quantification for some primer sets. (In addition, multiplex reactions are not possible.) To distinguish between correct and nonspecific PCR products, melting curves (Tm) are typically examined after PCR.

Advantages of Delta Gene™ Chemistry

Delta Gene™ Assays have sensitivity and linearity similar to probe-based assays. They enable users to take full advantage of the Biomark HD System with minimal experimental setup time using validated protocols. With Delta Gene™ assays, flexible groups of biologically-related genes are available for specific requirements, eliminating the need to use fixed content. Amplicons are designed to cross an intron whenever possible to avoid genomic DNA amplification.

Delta Gene Assays have sensitivity and linearity similar to probe-based assays. They enable users to take full advantage of the Biomark HD System with minimal experimental setup time using validated protocols. Amplicons are designed to cross an intron whenever possible to avoid genomic DNA amplification. Delta Gene Assays are available only through our D3 Assay Design website. Go to d3.fluidigm.com or contact the Fluidigm Assay Design Group (at assay_design_group@fluidigm.com) for more information.

EvaGreen Protocols

Appendices B and C describe two EvaGreen dye protocols for use on the Biomark (normal ramp rate 2 °C/s) and Biomark HD (fast ramp rates 5.5 °C/s):

Fast gene expression analysis method with EvaGreen. It uses EvaGreen with either the 48.48 or 96.96 Dynamic Array™ IFCs or the 192.24 Gene Expression IFC. See Appendix B: Fast Gene Expression Analysis Using EvaGreen on Biomark or Biomark HD for the protocols that use the Dynamic Array IFCs. See the document 192.24 Delta Gene™ Fast/Standard Gene Expression Workflow (PN 100-7222) for the protocol that uses the Gene Expression IFC.

Single-cell gene expression analysis method with EvaGreen. It involves cell sorting, reverse transcription and specific target amplification (RT-STA), and uses TaqMan with either 48.48 or 96.96 Dynamic Array IFCs. See Appendix C: Two-Step Single-Cell Gene Expression Using EvaGreen Supermix on the Biomark and Biomark HD Systems. For the protocol that uses the Gene Expression IFC, see the document 192.24 Delta Gene™ Fast/Standard Gene Expression Workflow (PN 100-7222).
Biomark Systems for Genetic Analysis

The Biomark™ Systems include the optical, thermal cycling, and software components necessary to perform real-time quantitative PCR (qPCR) analysis on Dynamic Array™ IFCs.

The Biomark™ Systems provide orders of magnitude higher throughput for real-time qPCR compared to conventional platforms due to its Dynamic Array™ IFCs — nanofluidic chips that contain fluidic networks that automatically combine sets of samples with sets of assays. This innovative solution for real-time qPCR provides reaction densities far beyond what is possible with microtiter plates and significantly reduces the number of liquid-handling steps and the volume per reaction.

High-End Detection Optics

The Biomark™ Systems includes a high-resolution CCD camera that covers 30mm by 30mm, an area sufficiently large to simultaneously image all reactions in Dynamic Array™ IFCs. The Biomark™ System optics and analysis software is available for different applications, which are compatible with a variety of Fluidigm chip families for TaqMan® chemistry. The system’s computer-controlled chip tray automatically loads the chip into the instrument for ease of use. A barcode reader tracks experiments, reducing the chance of errors.

Biomark System Components

Biomark™ Systems include an internal thermal cycler, flat panel monitor, keyboard, and mouse. (The Biomark™ HD System is pictured.)
Controllers for IFCs

Juno

Juno™ is a universal controller that primes, loads, and thermal cycles assay-sample mixes.

IFC Controllers

The controllers were designed specifically to work with specific chips:

- **IFC Controller HX**—for priming and loading the Flex Six™ Gene Expression IFC and the 96.96 Dynamic Array™ IFC.
- **IFC Controller MX** (pictured)—for priming and loading the 48.48 Dynamic Array™ IFC.
- **IFC Controller RX**—for loading the 192.24 Gene Expression IFC.
Integrated Fluidic Circuit (IFC) Components

Although chip architecture varies, the essential components, such as sample and assay wells and accumulators are common to all.

**192.24 Gene Expression IFC**

The Fluidigm 192.24 Gene Expression IFC meets the needs of production users who have narrowed their gene panel and require high sample throughput. Together with the Biomark™ Systems, this IFC enables maximum throughput with minimal hands-on time. The 192.24 Gene Expression IFC for can be particularly useful in clinical research and production environments, where users will benefit from the low-cost per sample, high reliability, and simple workflow of the IFC.

**24.192 Dynamic Array™ IFC for Gene Expression**

The Fluidigm 24.192 Dynamic Array IFC for gene expression supports the analysis of up to 192 markers per sample, the largest panel size of any Fluidigm gene expression IFC. The GE 24.192 IFC is well suited for customers who want to maximize data collection from rare samples. It is also a valuable tool in custom panel development, where it can be used to validate performance of potential gene expression assays prior to final panel selection and testing on a larger number of samples (for example, by using the 96.96 Dynamic Array IFC).
48.48 Dynamic Array™ IFC

The Fluidigm 48.48 Dynamic Array™ IFC is an efficient solution for large-scale, real-time qPCR. The key to this efficiency is the matrix of channels, chambers, and integrated valves finely patterned into layers of silicone. This material is gas permeable, allowing the blindfill of fluids into valve-delimited chambers. The valves partition samples and reagents and allow them to be systematically combined into 2,304 assays.

The significance of this approach to operational efficiency is immense. Managing a gene expression study involving 2,000 samples against a set of 48 genes would require 1,000 96-well plates as compared to 42 Dynamic Array™ IFCs. Managing the same study would require 192,000 steps on microplates but only 4,032 liquid-transfer steps on the IFCs. Comparative time required to complete such a study would typically involve 100 days on plates but just 4 1/2 days on IFCs. In addition, the running cost is reduced by half or more.

96.96 Dynamic Array™ IFC

The Fluidigm 96.96 Dynamic Array™ IFC is similar to the 48.48 Dynamic Array™ IFC but with high throughput. On one side of the frame are 96 wells to accept the samples and, on the other, 96 wells to accept the probe and primer pairs. Once in the wells, the components are pressurized into the chip using an IFC controller. The components are then systematically combined into 9,216 parallel reactions.

Flex Six™ Gene Expression IFC

The Fluidigm Flex Six™ Gene Expression IFC addresses the requirement for substantial variation in sample and assay numbers during target selection while allowing complete use of the IFC. It utilizes a completely new architecture which incorporates six 12 × 12 partitions that can be organized in any configuration, in up to six separate experimental runs. This new IFC adjusts to customers’ experimental needs during target selection and largely eliminates the need for microplate-based experiments.
Biomark System Workflow

The simplicity of running experiments on either Biomark System is illustrated in the process below.

**Workflow for 192.24 and 24.192 IFCs**

<table>
<thead>
<tr>
<th>Workflow Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Prepare and perform reverse transcription (RT) and/or preamplification reactions, as required by the specific protocol.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Prepare the final assay mixes and final sample mixes for real-time PCR.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Inject control line fluid into the top accumulator on the IFC.</td>
</tr>
</tbody>
</table>
| **4**         | Pipet each final sample and assay mix into the IFC, then load the IFC on Juno™ or the appropriate IFC Controller. Air pressure forces samples and assays into the IFC where they mix.  
**NOTE** Priming and loading on the 192.24 and 24.192 IFCs occurs in one step. |
| **5**         | Thermal-cycle and collect data on Biomark HD. |
| **6**         | Analyze data. |

**Workflow for all other IFCs**

<table>
<thead>
<tr>
<th>Workflow Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Prepare and perform reverse transcription (RT) and/or preamplification reactions, as required by the specific protocol.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Inject control line fluid into the top accumulator of the IFC, then prime the IFC on Juno or the appropriate IFC Controller.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Prepare the final assay mixes and final sample mixes for real-time PCR.</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>Pipet each final sample and assay mix into the IFC, then load the IFC on Juno or the appropriate IFC Controller. Air pressure forces samples and assays into the IFC where they mix.</td>
</tr>
<tr>
<td><strong>5</strong></td>
<td>Thermal-cycle and collect data on Biomark HD.</td>
</tr>
<tr>
<td><strong>6</strong></td>
<td>Analyze data.</td>
</tr>
</tbody>
</table>

**Before You Begin**

To ensure good experimental results, follow the guidelines listed below.

**Organizing Your Work**

- Label all reagent and reaction tubes.
- Maintain a separate DNA-free laminar flow hood—do not use nucleic acid samples in this hood.
- Use dedicated pipettes, tubes, and gloves for all manipulations that do not involve nucleic acid samples, which never leave the DNA-free (“Sample”) laminar flow hood.
Preventing Contamination

- Manipulate DNA samples under a dedicated laminar flow hood (for example, name it “Sample”).
- Use separate dedicated pipettes, tubes, and gloves for all manipulations involving nucleic acid samples, which never leave the DNA-dedicated laminar flow hood.
- Change gloves frequently.
- Use aerosol-resistant disposable pipette tips. Discard tips after each use.
- Use disposable, UV-irradiated plastic ware.
- Ensure that all equipment, including paper, pens, and lab coats are dedicated for use only in a particular laboratory. For example, dedicated laboratory coats for each of the PCR rooms.
- Do not bring contaminated workbooks into clean PCR areas.
- Aliquot PCR reagents.
- Wipe PCR hoods daily with DNAZap® (Ambion) or a similar DNA decontaminate.
- Use ultra-violet radiation to complete decontamination.
- Ensure that only authorized users work in PCR areas and handle PCR equipment.
- Prepare reagents in a dedicated DNA-free laminar flow hood. DNA-free areas prohibit any biological material, including DNA or RNA extracts, and PCR products. Also, in the DNA-free area, prepare and aliquot reagent stocks and reaction mixes.

Handling Nucleic Acid, PCR Mixes, and PCR Reactions

- Prevent carry-over of amplified DNA sequences by setting up PCR reactions in a dedicated laminar flow hood, while keeping post-PCR manipulations separate.
- Add extracted DNA to the PCR reaction mixes in the DNA-dedicated (“Sample”) laminar flow hood. Be sure to prepare the PCR reaction mixes in the DNA-free laminar flow hood.
- Keep the amplification room—where PCR machines are housed—separate from the room in which PCR reactions are assembled (DNA free laminar flow hood).

Using Controls

- Include—whenever possible—a positive control that amplifies weakly but consistently. Using a strongly positive control sample may result in excess amplified product which may serve as a source of contamination.
- Use well-characterized negative samples such as lambda DNA.
- Include reagent controls containing all the necessary reagent components but excluding test DNA.
- Use decontaminating enzymes such as uracil N-glycosylase (UNG) or Uracil-DNA Glycosylase (UDG) to further minimize the likelihood of contamination.
What You Need for Experiments

This section describes the materials that you need to perform your experiments including reagents we support and sample requirements. In addition, you need the following:

- Biomark™ System or Biomark™ HD System
- IFC Controller
- Flex Six IFC, 48.48 Dynamic Array™ IFC, 96.96 Dynamic Array™ IFC, or 192.24 Dynamic Array™ IFC
- 20X GE Sample Loading Reagent (Fluidigm PN 85000735, 85000746)—store at –20 ºC.
- 20X DNA Binding Dye Sample Loading Reagent (for EvaGreen protocols) (Fluidigm, PN 100-3738)—store at –20ºC
- 2X Assay Loading Reagent (Fluidigm PN 85000736)—store at –20 ºC.
- Deionized DNA-free, DNase-free, RNase-free water—store at room temperature.
- DNA Suspension Buffer (10 mM Tris, pH 8.0, 0.1 mM EDTA) (TEKnova, PN T0221)—store at room temperature.
- Sample Mix
- Prime/probes sets
- Samples of interest

Supported Detection Reagents

We support the following detection reagents with the Biomark™ Systems.

Probe Types

- FAM-MGB
- VIC-MGB
- FAM-TAMRA
- FAM-non fluorescent quencher

Additional Probe Types

Fluidigm does not support other probe types at this time, however, additional probe types may be run with the Biomark™ Systems using the following guidelines:

<table>
<thead>
<tr>
<th>Fluorophores With...</th>
<th>Excitation Wavelengths</th>
<th>Emission Wavelengths</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>between 465 and 505 nm</td>
<td>And</td>
</tr>
<tr>
<td></td>
<td>between 501 and 550 nm</td>
<td>And</td>
</tr>
<tr>
<td></td>
<td>between 540 and 600 nm</td>
<td>And</td>
</tr>
</tbody>
</table>
**PCR Master Mixes**

If you choose to use master mixes other than those specified in this guide, you may have to alter the protocol described in this guide. Contact Fluidigm Technical Support for additional information.

**IMPORTANT** You must use a passive reference.

**Sample Requirements**

**RNA Quality**

Your RNA should have an 260:280 Ratio between 1.5 and 1.8. Prior to use on a chip, monitor the integrity of your RNA on a system such as the Agilent® 2100 bioanalyzer.

**cDNA Preparation**

Synthesize cDNA as described in Appendix A: cDNA Preparation with Reverse Transcription Master Mix.

**cDNA Input**

The exact amount of cDNA to be used for each experiment depends on the relative abundance of the target gene. Unless you have concentrations in excess of 1,000 copies of your target template per μL of sample, increase the your target concentration by using preamplification as described in Fluidigm Gene Expression PreAmp with Fluidigm 5x PreAmp Master Mix and Delta Gene Assays Quick Reference (PN 100-5875) and the Fluidigm Gene Expression PreAmp with Fluidigm 5x PreAmp Master Mix and TaqMan Assays Quick Reference (PN 100-5876).

**cDNA Storage**

Avoid multiple freeze-thaw cycles by storing cDNA at 4°C. For longer storage, aliquots may be stored at -20°C.

**Reagent Storage**

Consult manufacturers’ product inserts for storing specific reagents.
Chapter 2: Using Real-Time PCR Analysis Software

Launching the Software

1. Double-click the Fluidigm Real-Time PCR Analysis icon on your desktop.

The Start screen opens.
Menus and Icons

Top Menu Bar

![Top Menu Bar Diagram]

Secondary Menu Bar

![Secondary Menu Bar Diagram]

File

The File menu has the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Open the Chip Run Setup Wizard</td>
</tr>
<tr>
<td>New From Current Chip Run...</td>
<td>Open a new version of the chip run you are currently analyzing</td>
</tr>
<tr>
<td>Open</td>
<td>Open location of .bml chip run data files</td>
</tr>
<tr>
<td>Open Multiple Chip Runs...</td>
<td>Open two or more chip runs and combine them in one view</td>
</tr>
<tr>
<td>Save</td>
<td>Save your current run data file with any changes</td>
</tr>
<tr>
<td>Convert to More Samples Chip Run...</td>
<td>Convert your chip run to a more samples chip run</td>
</tr>
<tr>
<td>Email Chip Run Information...</td>
<td>This function collects chip run information (.bml file, first and last cycle images) and attaches to an email that can be sent to Fluidigm Technical Support or other party to share information conveniently</td>
</tr>
<tr>
<td>Close</td>
<td>Close your current run data file</td>
</tr>
</tbody>
</table>
### Export

Export **Results** table data or **Heat Map** data as .csv text file

### C:...

Open the location of recently viewed/used .bml files

### Exit

Close the application

---

**Edit**

The Edit menu options depend on the active window.

<table>
<thead>
<tr>
<th>If the Active Window is...</th>
<th>Your Options Are...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Setup</strong></td>
<td><img src="image" alt="Sample Setup" /></td>
</tr>
<tr>
<td><strong>Detector Setup</strong></td>
<td><img src="image" alt="Detector Setup" /></td>
</tr>
<tr>
<td><strong>Details Views</strong></td>
<td><img src="image" alt="Details Views" /></td>
</tr>
<tr>
<td><strong>Results Table</strong></td>
<td><img src="image" alt="Results Table" /></td>
</tr>
</tbody>
</table>
Chapter 2: Using Real-Time PCR Analysis Software

Menus and Icons

<table>
<thead>
<tr>
<th>If the Active Window is...</th>
<th>Your Options Are...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image View</td>
<td><img src="image1.png" alt="Image View Menu" /></td>
</tr>
<tr>
<td>Heat Map</td>
<td><img src="image2.png" alt="Heat Map Menu" /></td>
</tr>
</tbody>
</table>

View

Select **Chip Explorer** and/or **Task** to display these panes in your window.

Report

Two reports are available:

- **Chip Preparation Report**

  This report records the loading pattern for a chip run. After creating a new chip run file, use the **Chip Preparation Report** to record the data for hand-pipetting.
• Install Test Report

This report is only available after a chip run (.bml) file has been opened and analyzed in the software.

Install Test Report

1 Select **Report > Install Test Report**.

A warning about properly setting up the chip appears. Click **OK** if the setup is correct. The report is generated.

2 Go to **File > Export Document**…. to select a file format. PDF is the default.

3 Select a folder location to save the file.

4 Change the Name and/or file type, if needed.

5 Click **Save**.
Tools

The Tools menu has the following options:

See Using the Dispense Map Editor on page 39.

Using the Biomark Image Viewer

You can view saved Biomark images in *.tif or *.j2k format by selecting Tools > Biomark Image Viewer.

Biomark Image Viewer Tool Bar

Elements of the Biomark Image Viewer tool bar are shown below.
**Zoom**

You can increase or decrease the image view size in several ways:

- Multi-click the magnifying glass buttons (+ and −).
- Click **100%**.
- Click **Fit** to fit image to width.

Click inside Image View and then roll the mouse scroll wheel (up/backward = larger, down/forward = smaller).

**Options**

You can modify your report options and customize your analysis parameters (see Customizing the Analysis Parameters on page 26) by selecting **Tools > Options**.

You can change the following report export options:

- **Default folder.** In the Default Folder drop-down menu, you can select Chip Run Folder or User Specified Folder. If you select User Specified Folder, you can browse to the folder where you want to save the results or report.
- **Export comments.** When this options is enabled, the report includes the user-defined comments in the exported data.
- Substitute “Flag” with “Fail.” When this option is enabled, the Flag label for the cycle threshold (Ct) calls is substituted with Fail.
Customizing the Analysis Parameters

You can customize the cycle threshold (Ct) and melt curve analysis (MCA) settings before you open a chip run. This change will apply only to chip runs that have not been previously analyzed.

**IMPORTANT** If you change the default analysis parameters on a shared workstation, the default parameters will be changed for all users.

After launching the Real-Time PCR Analysis software.

1. Select Tools > Options.
2. In the Options dialog box, click **Analysis Parameters**.

3. Check the boxes for the parameters that you want to customize, then select or enter the desired settings. All unchecked boxes will use the original default settings.
Creating a New Chip Run

1. Click creating a new chip run under Chip Run Summary or click Create a New Chip Run under Task.

The Chip Run Setup Wizard opens.

2. Follow the steps to complete the setup.
3 Complete the wizard and go to:
   • Setting Up and Annotating a Sample Plate on page 32 to set up a sample plate.
     OR
   • Setting Up and Annotating a Detector (Assay) Plate on page 42 to set up an assay plate.

Opening an Existing Chip Run

1 To analyze a previous chip run, click **opening an existing chip run** in the Welcome screen (Chip Run Summary) or click **Open a Chip Run** under **Task** or click **File > Open**.

2 Double-click the chip run file (.bml extension).

The chip run file opens.

**NOTE** You cannot open a chip run if another use is analyzing it.
3 Click Details Views.

4 Click Analyze.

**IMPORTANT** You must click Analyze each time you change parameters. A reminder dialog appears if you do not click Analyze after each change.

The first time a chip is analyzed, the chamber-finding algorithm locates the chamber boundaries of each captured image. This may take some time.

Continue to:

- Setting Up and Annotating a Sample Plate on page 32 to set up a sample plate.
  OR
- Setting Up and Annotating a Detector (Assay) Plate on page 42 to set up an assay plate.

**Finding Corners Manually (if required)**

**NOTE** If the chamber finding algorithm cannot locate the four corner cells of the chip during the first analysis, the following error message will appear.

If this occurs, you can manually set the corners and then analyze the chip.

1 Click **OK**.

The Set Corners of the Chambers Area dialog box appears.

2 Zoom in to see the corner cells.
NOTE
- If you cannot see the four corner cells, adjust the Contrast slider. If an insufficient amount of ROX dye was used in setting up the IFC corners, it will be difficult to see the corner cells.
- The chamber-finding algorithm supports gene expression assays in 96.96 IFCs with bright reagent chambers.

3 Position the corners of the red box at the perimeter of the chip image.

4 Make sure each corner is placed on the outer edges of each corner cell, as displayed in this image:

5 Click Done.

NOTE If no ROX is present, the corner cells are very dark. You may have to count the number of rows and columns (48 down, 48 across for the 48.48 IFC for example) to make sure you are placing cross hairs correctly.

If the algorithm cannot detect ROX in the cells, it displays the chambers as blue dots.

6 You can drag the red box corners to the corner chamber locations to match the cells to chambers.
Forced Manual Corner Find

If the automated manual corner find results are not satisfactory, you can perform a forced manual corner find by pressing the CTRL key and simultaneously clicking on the Analyze button.
Setting Up and Annotating a Sample Plate

This procedure shows you how to create a new sample plate with annotations.

**NOTE** Click **Import** to import the sample information from a plate file or a comma-separated values (CSV) file.

1. In the Chip Explorer window, select **Sample Setup**.

2. Click **New**. The **Sample Plate Setup Wizard** opens.

3. Choose the appropriate sample and detector (assay) plates and their formats:

<table>
<thead>
<tr>
<th>Container type</th>
<th>Container format</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBS Plate: the plates where samples and detectors are stored before being pipetted into chip.</td>
<td>SBS96: a 96-well plate. For 192.24 IFCs, two source plates are provided for annotating samples.</td>
</tr>
<tr>
<td>Sample Inlets: location on the chip where samples are entered.</td>
<td>SBS384: a 384-well plate.</td>
</tr>
</tbody>
</table>
4 Click **OK**.

5 Annotate the cells of the sample plate:

a In the Sample Setup pane, select 1 or more cells. For example annotate 1 or more cells as the Reference or Standard, then annotate all samples as the Unknown annotation type. (By default, all the cells in the Sample Setup pane are annotated as **Unknown**.)

You can select multiple cells in any of the following ways:

- Click the upper left corner to select all the cells.
- Click and hold while dragging your cursor through adjacent cells.
- Click individual cells while pressing the **CTRL** key.

b (Optional) Click the **Map** icon to view at-a-glance the selected cells in the entire plate. For example:
The Map. If you selected SBS Plate as your container type, clicking the Map icon opens a sample plate map. If you selected Sample Inlets, clicking the Map icon opens a sample inlet map.

c (Optional) You can expand all the cells at the same time. Double-click between columns:

d Click Editor.

The Sample Editor opens.

e Select the appropriate annotation type.

NOTE To identify a reference, see Calculating Delta Ct Sample Values on page 104.
Sample annotation definitions are as follows:

<table>
<thead>
<tr>
<th>Sample Annotation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>An unused position. Nothing in the chamber. Blank samples will not be used in the Auto Ct Threshold calculations.</td>
</tr>
<tr>
<td>NAC</td>
<td>No Amplification Control: usually the Taq polymerase is left out of the reaction, but ROX still needs to be included for chamber finding. (This is meant to be a negative control confirming that positives cannot occur without the PCR working.) Blank samples will not be used in the Auto Ct Threshold calculations.</td>
</tr>
<tr>
<td>NTC</td>
<td>No Template Control (negative control): everything included except the sample; to show that a positive result cannot be obtained when the sample is left out.</td>
</tr>
<tr>
<td>Unknown</td>
<td>An experimental sample.</td>
</tr>
<tr>
<td>Reference</td>
<td>A sample against which the unknown samples are compared or normalized.</td>
</tr>
<tr>
<td>Standard</td>
<td>A sample against which unknown samples are compared in a standard curve analysis.</td>
</tr>
</tbody>
</table>

6. Enter the sample name and relative concentration in the Sample Name and Relative Conc., then click Update. (Click the X in the upper-right corner to close this window.) The sample plate in the Sample Setup pane reflects the information.

7. Repeat Step 6 as needed to annotate all the cells in the Sample Setup pane, then click the X in the upper-right corner to close the Sample Editor window.

8. In the Task pane, enter the well plate source, name, and barcode plate information:

   ![Image of Task pane with mapping option]

9. At the right of the Mapping box, click the Map icon to open the Open Sample Mapping File window:
10 In the **Open Sample Mapping File** window, select either the left or right sample mapping file (in dsp format) to determine dispense location:

**NOTE** If you are analyzing a 192.24 Gene Expression IFC, you have several options: 192-Sample-SBS384 (left or right).dsp, 192-Sample-SBS96 (left or right).dsp, or 192-Sample-SBS96 (Even or Odd).dsp.

**NOTE** For Flex Six chip runs, you must manually annotate according to inlets.

11 Click **Open**. Your selection is displayed in light blue (left or right).
The Mapping box now contains the name of the file that you chose for dispensing the sample into the sample plate:

Your sample plate setup is complete. Next, go to Using the Sample Mapping Viewer.

**Using the Sample Mapping Viewer**

Use the **Sample Mapping Viewer** to view or record the loading pattern after setting up the sample plate.

1. Click **Sample Mapping View**. The dispensing map opens.
2. Click a cell in the **Source Plate** to see where it loads on the **Target Plate**.
NOTE If you click an unused cell, the “Well not used” warning appears.

Using the Replay Control

Use the **Replay Control** to show where and in what sequence the **Target Plate** receives the samples from the **Source Plate**.

Plays the sequence from start to finish, one row at a time. Click it once to pause. Then click again to continue.

Advances the loading one row at a time with each click toward the end

Moves the loading to the end position

Moves the loading back one row at a time with each click toward the start

Returns the loading to the start position

Clears the map.

Start position

End position
Using the Dispense Map Editor

Use the **Dispense Map Editor** to record custom load maps for future use. After recording your loading sequence, you can save it and play it back anytime.

1. Click **Tools > Dispense Map Editor**.
2. Click **New**. The **New Dispense Map** window opens.
3. Complete the **New Dispense Map** using the following as a guide.

4. Click **OK** to open the new dispense map in the **Dispense Map Editor**.

5. Click **Begin Editing** in the recording control pane.
a. Click the first cell from the **Source Plate**. Then, click the location in the **Target Plate**.

b. Continue clicking appropriate cells (from the **Source Plate** to the **Target Plate**) until your custom loading map has been recorded.

**NOTE** When you click **Begin Editing**, the dispensing pane becomes inactive.

6. Click **Stop Editing**.

These graphics show custom loading and how it looks as you proceed.
7 Review the loading pattern you have recorded by clicking the green arrow button in the playback control pane.
Setting Up and Annotating a Detector (Assay) Plate

This procedure shows you how to create a new detector plate with annotations.

NOTE  Click Import to import the detector information from a plate file or a comma-separated values (CSV) file.

1  In the Chip Explorer window, select Detector Setup.

2  Click New. The Detector Plate Setup Wizard opens.

3  Choose the appropriate detector (assay) plates and their formats:
Chapter 2: Using Real-Time PCR Analysis Software
Setting Up and Annotating a Detector (Assay) Plate

4 Click **OK**.

5 Annotate the cells of the detector plate:

a In the Detector Setup pane, select 1 or more cells. For example annotate 1 or more cells as the Reference or Control, then annotate all detectors as the Test annotation type. (By default, all the cells in the Detector Setup pane are annotated as **Test**.)

You can select multiple cells in any of the following ways:

- Click the upper left corner to select all the cells.
- Click and hold while dragging your cursor through adjacent cells.
- Click individual cells while pressing the **CTRL** key.

b (Optional) Click the **Map** icon to view at-a-glance the selected cells in the entire plate. For example:

<table>
<thead>
<tr>
<th>Container type</th>
<th>• <strong>SBS Plate:</strong> the plates where samples and detectors are stored before being pipetted into chip.</th>
<th>• <strong>Sample Inlets:</strong> location on the chip where samples are entered.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container format</td>
<td>• <strong>SBS96:</strong> a 96-well plate. For 192.24 IFCs, two source plates are provided for annotating detectors.</td>
<td>• <strong>SBS384:</strong> a 384-well plate.</td>
</tr>
</tbody>
</table>
The Map. If you selected SBS Plate as your container type, clicking the Map icon opens a detector plate map. If you selected Detector Inlets, clicking the Map icon opens a detector inlet map.

(c) (Optional) You can expand all the cells at the same time. Double-click between columns:

(d) Click Editor.

The Detector Editor opens.

(e) Select the appropriate annotation type.

**NOTE** If you want to identify a reference before moving on, see Calculating Delta Ct Detector Values on page 107.
Detector annotation definitions are as follows:

<table>
<thead>
<tr>
<th>Detector Annotation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>Experiment reagents, which will be used by Ct Threshold method Auto By Control (Global).</td>
</tr>
<tr>
<td>NRC</td>
<td>No Reagent Control: negative control using only buffer, no primers/probes (detectors) NRC detectors will not be used in the Auto Ct Threshold calculations.</td>
</tr>
<tr>
<td>Reference</td>
<td>A reference gene</td>
</tr>
<tr>
<td>Blank</td>
<td>No gene or assay reagents Blank detectors will not be used in the Auto Ct Threshold calculations.</td>
</tr>
<tr>
<td>Control</td>
<td>A control gene</td>
</tr>
</tbody>
</table>

6. Enter the detector name and relative concentration in the Detector Name and Reference, then click Update. (Click the X in the upper-right corner to close this window.) The detector plate in the Detector Setup pane reflects the information.

7. Repeat Steps 5 and 6 as needed to annotate all the cells in the Detector Setup pane, then click the X in the upper-right corner to close the Detector Editor window.

8. In the Task pane, enter the well plate source, name, and barcode plate information:

9. At the right of the Mapping box, click the Map icon to open the Open Detector Mapping File window:
10 In the **Open Detector Mapping File** window, select either the left or right detector mapping file (in dsp format) to determine dispense location.

11 **Click Open.** Your selection is displayed in light blue (left or right).

The Mapping box now contains the name of the file that you chose for dispensing the detectors into the detector plate:

Your detector plate setup is complete.
Advanced User Options

Converting a Chip Run to a More Samples Run

A More Samples run requires its own sample and assay setup, and Fluidigm provides the necessary Microsoft Excel setup templates for you.

Follow these steps to convert a chip run to a More Samples run:

- Step 1: Set up your samples
- Step 2: Set up your assays
- Step 3: Import the samples and assays to the Analysis software

Step 1: Set Up Samples

1. Go to:
   C:\Program Files (x86)\Fluidigm\BioMarkDataAnalysis\ApplicationData\FileFormats

2. Open SamplePlateDefinitionForMoreS.

3. Click Options to enable Active X (if prompted).

4. If prompted, select *Enable this content* in the Microsoft® Office Security Options dialog.

5. Click OK.

6. Edit the Microsoft Excel template to match your experiment. For example:
Chapter 2: Using Real-Time PCR Analysis Software
Advanced User Options

7. **Click Create Plate CSV File.**

8. Open the new CSV file tab and double-check your annotations. For example:

9. **Click Save to a CSV file** to save the file and select a location to save it.
Step 2: Set Up Assays

1. Open AssayPlateDefinitionForMoreS.
2. Edit the Microsoft Excel file to match your experiment.
3. Click Create Plate CSV File. A second CSV file tab is added to the file.
4. Open the new CSV file tab and double-check your annotations.
5. Click Save to a CSV file to save the file and to select a convenient location for future retrieval.

Step 3: Import the Sample and Assay Templates

To Import the Sample template files:

1. From the Data Analysis software, open a chip run you want to annotate.
2. Select Sample Setup.
3. Click Import under Task.
4. Browse to the location where you saved your sample template.
5. Click Open.

To Import the Assay template files:

1. From the Data Analysis software, open a chip run you want to annotate.
2. Select Assay Setup.
3. Click Import under Task.
4. Browse to the location where you saved your assay template.
5. Click Open.

Importing Multiple Chip Runs

You can import multiple chip runs to increase data points. This can be done to combine the individual arrays of Flex Six IFCs, or to combine multiple 48.48, 96.96 or 192.24 Dynamic Array™ IFCs.

This feature requires some pre-planning on your part, however. The function enables combining multiple chip runs in a two dimensional layout, meaning you can add chip runs down the sample axis and/or the assay axis.
NOTE There should be uniformity across the chip runs. Samples and Assays of the chip runs must be set up the same, annotated the same, run on the same machine and in a similar time frame.

NOTE To ensure consistent annotation, you can annotate the samples/assays of the first chip, then export the .plt file. Then, import the same .plt file to annotate the other chip runs.

1 Click File > Open Multiple Chip Runs.

2 Click the folder containing the multiple chip runs.

3 Click the arrow to move all the chip runs in the folder to the other pane. Alternately, expand the multiple chip run folder and choose specific .bml run files, clicking the arrow for each file that you want to add to the other pane. Alternatively, you can select files from various folders.

4 Type a name.

5 Click Browse.
6 Navigate to a location to store the data.

7 Click **OK**.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Working with Analysis Settings

You can customize these analysis settings:

- Quality Threshold
- Baseline Correction
- Ct Threshold Method

To change the settings:

1. Launch the Real-Time PCR Analysis software.
2. Click Details Views. Analysis settings are located under Task.

Changing the Quality Threshold

The Quality Threshold in the Biomark system analysis software is a qualitative tool designed by Fluidigm to measure the quality of each amplification curve. Each curve is compared to an ideal exponential curve and given a Quality Score between 0 and 1, where 0 is a flat line and 1 is a perfect sigmoid.
The default cutoff of 0.65 is an arbitrary value set by Fluidigm. Any curve above 0.65 passes. Any curve below, fails. This does not mean that the curve or threshold cycle (Ct) value is invalid. The Ct value is the cycle number at which the signal is detectable above the background. The Quality Threshold value is meant to flag potential problematic or suboptimal curves so that you can assess if they are true growth curves or artifacts. Once reviewed, you can change the quality value to Pass.

To change the quality threshold:

1. Click **Details Views**.
2. Under **Analysis Settings**, enter a different value in the **Quality Threshold** field.

### Changing the Baseline Correction

To change the baseline correction:

1. Click **Details Views**.
2. Under **Analysis Settings**, select a different option in the **Baseline Correction** field.

<table>
<thead>
<tr>
<th>Baseline Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Constant</strong></td>
</tr>
<tr>
<td><strong>Linear</strong></td>
</tr>
<tr>
<td>Produces higher Ct values when the amplification is low. Linear baseline correction eliminates baseline “drift” by flattening the baseline.</td>
</tr>
<tr>
<td><strong>Linear (Derivative) [default]</strong></td>
</tr>
<tr>
<td>An additional method of baseline correction with a more robust handling of chamber-to-chamber baseline variation.</td>
</tr>
</tbody>
</table>
The difference between **Constant** and **Linear** baseline corrections is shown here:

**Constant** baseline correction
Baselines are rising in the **Constant** correction (shown as black fill).

**Linear** baseline correction
Baselines are flattened in the **Linear** correction

### Changing the Ct Threshold Method

To change the quality threshold:

1. **Click** **Details View**.
2. Under **Analysis Settings**, select an option in the **Ct Threshold Method** field.

**Auto (Global)**. This setting automatically calculates a threshold that is applied to the entire chip. This setting excludes Blank samples and assays, NTC samples, and NRC assays when calculating a Ct threshold.

**Auto (Detectors)**. This setting independently calculates a threshold for each detector on a chip. This setting excludes Blank and NTC samples when calculating a Ct threshold. You must enter a unique detector name in the **Detector Editor** during detector setup.

**User (Global)**. This setting allows you to manually adjust the threshold when searching for the Ct rise in slope. The value is applied to all the detectors.

**User (Detectors)**. This setting allows tighter control when searching for the Ct curve's rise in the slope. You can individually set the threshold for each detector on the **Ct Thresholds** tab.

**Auto By Control (Global)**. This setting automatically calculates a threshold from the assays annotated with Control type. The threshold applies to the entire chip.
Select the Initialize with Auto checkbox to reset the threshold values using the Auto Detector method. Click Analyze to update the results.

If you include one or more Control detectors in your assay, where the Ct Threshold Method is User (Detectors), the Analysis Settings provides you with a Ct Thresholds tab. For this analysis, the Ct threshold method only uses the Control detector assay to determine the Ct threshold:

For example:
Saving or Loading Threshold Settings

To save your detector threshold settings for use with another chip run, right-click anywhere in the threshold table and select **Save Table**. Name the file and choose the location where you want to save the file.

To load your saved detector threshold settings, select **Load Table**. Browse to the location of the settings file you want.

Working with Details Views

The Details Views section contains the following views:

- **Results Table** -- view results in one table
- **Image View** -- view images from individual cycles
- **Heat Map View** -- view color-coded $C_t$ values
- **Dual Views** -- view two primary views (Results and Heat Map, for example) side by side

Click the **Expand/Collapse** button to display any view at full size or as split screen.

Using the Results Table

To access the Results Table:

1. Click **Details Views**.
2. Select **Results Table**, if it is on a different view.
In the **Results Table** view, right-click a column header to:

- Adjust columns, see page 57
- Group columns, see page 58
- Sort columns, see page 63
- Column Chooser, see page 63
- Customize search filters, see page 66
- Add user defined comments, see page 67

In this example, right-click the **Name** column header to open the options menu.

### Resizing Columns

#### Using the Cursor

- Position the cursor on a column edge. When the cursor changes to a double arrow, hold and drag the column bigger or smaller.
- Or

- Double-click the column edge to adjust the column to precisely fit the contents.

#### Using “Best Fit”

- One column: right-click a column header and select **Best Fit**. The column automatically adjusts to precisely fit the contents.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Working with Details Views

- All columns: right-click a column header and select **Best Fit (all columns)** to adjust all columns to precisely fit the contents.

![Image of a details view with column headers and options]

**Grouping Two or More Columns**

1. Right-click on any column header.
2. Click **Show Group by Box**.

![Image of a details view with a grouping bar]

The grouping bar appears.

![Image of a details view with column headers and options, showing a grouping bar]
3 Click the column header that you want to group and, while holding down the mouse button, drag it to the bar as shown below.

   a. Click and hold mouse button on header.

   b. Drag to any place on the bar.

   c. Release mouse button and header snaps to position at the left.

The data are now grouped by name in the Results Table.

4 Group as many elements as you like by dragging and dropping, as in the example below.
5 Drag and drop one header element over another as shown below to change places (hierarchy). The hierarchy dictates how the data displays as you expand windows.

In this example, the **ID** header is dragged over the **Type** header and then dropped. They exchange places as a result.
Ungrouping One Header

1. Right-click a header within a group.
2. Click **Ungroup** to remove the header from the group.

Ungrouping All Headers

1. Right-click anywhere on the grouping bar.
2. Click **Clear Grouping**.

Expanding and Collapsing All

1. Right-click anywhere on the grouping bar.
2. Click **Full Expand**. The grouped windows expand as shown below.
3. Collapse all by right-clicking anywhere on the grouping bar.
4. Select Full Collapse.
Sorting Columns

1. Right-click a column header.
2. Choose either **Ascending** or **Descending** to sort that column accordingly.

Unsorting Columns

1. Right-click a sorted column header.
2. Click **Clear Sorting**.

Column Chooser

Depending on how you set up your sample plate and detector plate, you can have 20+ columns in the **Results Table**, all of which are not viewable at once. To temporarily remove columns not of immediate interest, follow the procedure below.

1. Right-click a header.
2. Click **Column Chooser**. The **Customization** dialog opens.
3 Drag and drop unwanted column headers onto the **Customization** dialog.

4 Replace the column headers by dragging them from the **Customization** dialog to their original position.

**Dropdown Menus on the Column Headers**

Each column header has a dropdown menu. Place your cursor over a header to reveal the symbol.

1 Click the dropdown menu symbol to display the menu.

2 Click a location to go to that location.
3 **Click and drag the menu to size it.**

4 **Click All to expand the table to its original view.**
Custom Filters

Use filters to narrow your search for a particular parameter. In the following example, we isolate \( C_q \) quality values below 0.8.

1. Click the **Quality** header menu.
2. Click **Custom**.

The Custom AutoFilter dialog box opens.

3. Delimit your search:
   a. Select a filter.
   b. Enter the target value (0.8 in this example).
   Or
   c. Click the **Field** checkbox to activate the menu and select a filter.

4. **Optional:** Continue delimiting your search by clicking **And/Or** and then selecting filters from the menus.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Working with Details Views

A user can add comments to each chamber in the Results table. In addition, macros can be set up to apply common comments to multiple chambers.

1. Click on the **Results Table** menu.

2. Click on the **Comments** button.

3. Enter a comment, such as “C_t”.

4. Click **OK** to apply to first chamber.

5. Or, click the **Show Accelerator Keys** button.

6. Enter a comment that will be used frequently, “C_t”, for example, in the Enter Comments box.

7. Select the preferred Accelerator Key and repeat the comment. F2 was used in this example.

5. Click **OK**.

**Adding User Defined Comments**

The Add Comments and Accelerator Key Definitions dialog box appears.

3. Enter a comment, such as “C_t”.

4. Click **OK** to apply to first chamber.

5. Or, click the **Show Accelerator Keys** button.

6. Enter a comment that will be used frequently, “C_t”, for example, in the Enter Comments box.

7. Select the preferred Accelerator Key and repeat the comment. F2 was used in this example.
8 Click the **Save As Default** button.

Now you can select chambers you wish to add this comment to and simply press the F2 key.

### Using the Image View

View images from individual cycles in this window.

1 Click the **Results Table** menu.

2 Click **Image View**.

The default **Image View** opens.
3 Select a dye.

4 Select a cycle number from the **Cycle Selection** menu.

**IMPORTANT** An image displays only after you have selected a dye and a cycle number. A representation of the chip displays in the Image View.
5 Optional: Click the double arrow to expand the image.

Image View Tool Bar

Elements of the Image View tool bar are shown below.

- Expand Image button
- Click to enlarge to 100%
- Displays local reference map
- Auto contrast adjustment
- Manual adjust contrast slider
- Dye selector
- Toggles overlay On and Off
- Cycle image drop-down menu
- Fit image by auto, width, or height

Zoom

You can increase or decrease the image view size in several ways:

- Multi-click the magnifying glass buttons (+ and −).
- Click **100%**.
- Click **Fit** to fit image to width.
- Click inside Image View and then roll the mouse scroll wheel (up/backward = larger, down/forward = smaller).
Location Reference Map

Use the location map to reference your cell of interest within the entire framework of the chip.

1. Click the Location Reference map icon to open the map.
2. Click and drag the blue rectangle to a location of interest. In the example below, the blue rectangle within the Location Reference map is dragged to the green cells which enlarges the green cells in the Image Viewer.

Dragging the blue rectangle to an area of interest focuses that area in the Image Viewer.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Using the Image View

Adjusting the Size of the Location Reference Map

The size of the image in the Image Viewer determines the size of the blue rectangle in the Location Reference Map.

In the example below left, the image is has not been zoomed so the blue rectangle on the map is large. In the example below right, the image has been enlarged (by clicking in the Image View and then rolling the scroll wheel on the mouse).

Selected cells in the Image View are also displayed in the Graph View:

Enlarged image in the Image View, with four cells selected.

Graph View displaying the amplification plots and dye intensities of the four selected cells.

Raw data, amplification plots, and dye intensities are displayed in the Graph View when cells are selected in the Image View.
### Overlay

1. Click the Overlay icon to activate the red-square grid.

2. Click the Overlay icon again to inactivate the red-square grid.

![Toggle grid off](image1.png)  
![Toggle grid on](image2.png)

### Contrast (Auto or Manual)

You can apply contrast adjustments to all the dyes at once or to each dye individually by selecting **All** or **Individual** from the Contrast drop-down menu.

![Contrast settings](image3.png)

To adjust image contrast:

- Click the Auto-Contrast icon.

  ![Auto-Contrast](image4.png)

  Or,

- Move the contrast sliders by placing your cursor over a slider, then click and drag.

### Dyes

Change the dyes.

![Dye selection](image5.png)

Select **Fuse** to assign dyes to color channels to view the difference in intensity across multiple dyes in a single image. See **Fused Image View on page 74** for more information.

### View Image in Each Cycle

Use the menu to select an image to view. Select number 7 in the menu, for example, and the image taken at cycle 7 displays in the **Image Viewer**.
Fused Image View

If the chip run you are analyzing has more than one color, the **Fuse** option will be available in the dye selection drop-down menu so that you can view the difference in intensity across multiple dyes in a single image.

To utilize the fuse image view:

1. Click the **Results Table** menu.
2. Click **Image View**.
3. Select **Fuse** from the dye drop-down menu.

The Assign Color Values dialog box appears.

4. Select a color for each dye.
5. Select which dye you wish to overlay on top of the other. For example:

6. Click **OK**.
7. You can click on **Fuse** again to change any parameter. For example:
Using the Heat Map

The heat map color codes $C_t$ values for easy reference.

To access the heat map view:

1. Click **Details Views** in the Real-Time PCR Analysis software.
2. Go to **Heat Map View**.

The default heat map opens.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Using the Heat Map

NOTE A black square indicates no Ct value or a value outside of the spectrum range, as shown in the example below. Also, negative controls that do not show amplification appear as black squares.

NOTE An X signifies an amplification curve marked as Flag.

3 Optional: Click the double arrow to expand the image.

4 Optional: Hold your cursor over a cell of interest to view its information.
5 Optional: Click the cell of interest to view its information on the task bar.

6 Optional: select a row or a column by clicking an inlet or using the right-click menu as shown below.

7 Optional: Click the upper left corner in the heat map to select all cells.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Using the Heat Map

Heat Map View Tool Bar

Color Lookup Editor

You can define a range of valid $C_t$ or $T_m$ values using the Color Lookup Editor.

1. Click the Color Lookup Editor button.
2. Click Edit.
3. Choose $C_t$-YellowToBlue or $T_m$-YellowToBlue.
4 Click **Edit** at the right of your color choice. The **Spectrum Editor** opens.

5 Choose **RGB** (red, green, blue) or **HSL** (hue, saturation, lightness). (The RGB setting in Step 4 is a placeholder.)

6 **Optional:** Change the percentage increments between colors by changing the number.
   a. Click **Edit**.
   b. Change the value (from 1 to 20).
   c. **Optional:** Click **Invalid Color Data** to change the color of failed cells, then click one of the basic colors or click Define Custom Color and pick a the customized color of your choice.
Click OK in the appropriate Color windows.

d Click OK in the Spectrum Editor.

e Click OK in the Color Lookup Editor.

The change is reflected in the heat map and in the legend.

**Color Range Pane in the Color Lookup Editor**

You can change the following parameters:

- Number of color segments
- Minimum value
- Maximum value
- Find Range
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Using the Heat Map

Changing the Number of Color Segments

Change the segments shown in the heat map.

1. Type a value (2 minimum).
2. Click OK to reflect changes in the legend.

The examples below illustrate that the greater the number of color segments, the finer distinction between legend values.

2 Color Segments

10 Color Segments

Changing Minimum Values

Change the minimum value when you want to exclude a segment from the lower range. For example, changing the value from 1 to 10, excludes any Ct value from 1 to 10 as the example below illustrates.

1. Enter a value.
2. Click OK.
Segments with values from 1 to 10 have been eliminated as the minimum acceptable value is now greater than 10. As a result, the lowest value on the legend is now over 10.

**Changing Maximum Values**

Change the maximum value when you want to exclude a segment from the higher range (from 1 to 39). For example, changing the maximum value from 35 (default value) to 10, any Ct or Tm values above 10 are excluded (gray area), as the example below illustrates.

1. Enter a value.
2. Click **OK**.

When you click **OK**, the heat map and the legend reflect the change also.

**Using Find Range**

Find range allows you to eliminate a percentage of the upper and lower ranges of all valid Ct or Tm values.

1. Click **Find Range**.
2 Change the values.

In the example below, the minimum and maximum values have been changed to 3.0. Therefore, after discarding the lower and upper 3.0% of valid values, you are left with a range of 10.08 to 25.16.

This range is represented in the Color Lookup Editor illustrated below. Note the eliminated values (from 1 to 10.08, and 25.16 to 39) are now gray areas.

3 Click OK to see the changes in the heat map and the heat map legend.

**Saving Changes**

To save custom parameters that you have set:

1 Click Save.

2 Enter a name for your custom parameters.

3 Click Save.
The **Color Lookup Editor** opens.

4. Click the **Color Scheme** menu to see the saved parameters.

**Location Reference Map**

Use the location map to reference your cell of interest within the entire framework of the chip.

- Click the **Location Reference map** icon to open the map.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Using the Heat Map

Legend

The legend is a color representation of the $C_t$ or $T_m$ values displayed on the heat map.

- Click the **Legend** icon.

![Legend Image]

Preferences

Click the **Preferences** button.

![Preferences Options]

- Show Grid
- Show Cell Text
- Preferences
- Show Column Headers (192.24 IFCs only)

Changing Grid and Selected Cell Color Preferences

To change heat map grid lines:

1. Click **Preferences**.
2. Click the **Grid line color** rectangle.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Using the Heat Map

The color palette opens.

3 Click on a color.

4 Click OK.

5 Click the Show Grid box.

6 Click OK. The new color grid lines display in the heat map.

7 Optional: Click Show Grid again to toggle the grid on and off.

To change the color of the borders of selected cells:

1 Click the Preferences button.

2 Click the Selection frame color rectangle.

The color palette opens.

3 Click a color.

4 Click OK. Frames of selected cells now show the new color in the heat map.
Selected cells in yellow, with the grid on:

Selected cells in yellow, without the grid on:

**Show Cell Text**

To show the details of a cell in text:

1. Click **Show Cell Text**.

Heat map cells are enlarged and text is now visible.
2 Optional: Click **Show Cell Text** again to toggle the text view on and off.

**Zoom**

Increase or decrease the image view size by mult-clicking the magnifying glass icons (+ and −).

**Layout View**

Toggle between inlet-based, chip-based, and custom views in the heat map.

**Inlet-Based View**

The inlet-based view shows the cell in the same numbered sequence as the inlets on the chip, as shown below.

**Chip-Based View**

The chip-based view shows a sequence of numbers assigned to chambers on a chip counting from top-left corner to the right and then, top to bottom.
Custom View

The Custom View selection adds two buttons to the tool bar, one to modify the column layout and one to modify the row format. Both function in the same manner (see detailed description below). Any modifications are rendered immediately in the heat map. The changes will be saved with the chip run.

From within the B dialog, customize the heat map layout by changing the way rows and columns are displayed. Use the graphic below as a guide.

To change row order:

1. Click the row order button. The Row Order [Sample] dialog opens.

Group, reorder, and hide rows and columns as needed.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Layout View

- Sort names in ascending order
- Sort names in descending order
- Sort numbers in ascending order
- Sort indices in descending order
- Move selection up one position
- Move selection down one position
- Move selection to Hidden panel
- Move all to Hidden panel
- Move selection to Visible panel
- Move all to Visible panel

When enabled, will hide or show all rows and columns that share the same name as the selection.

Click and drag the cursor to select a group
Using the Graph View

The graph view displays the curve data and information about the current selection of chambers. The secondary tool bar allows you to change the display of the data.

Graph Viewer Tool Bar

- Expand/collapse pane
- Change threshold by clicking and dragging threshold line
- Clear or Clear All manual changes
- Switch between two graphs
- Add or remove the C<sub>t</sub> threshold baseline
- Manually change pass or fail
- Animate a cell sequence
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Using the Graph View

## Toggling the Threshold

Click the **Threshold** button to apply a $C_t$ threshold line to the amplification graph.

![Amplification Graph with Threshold](image)

**With threshold baseline**

## Using the Graph Edit Button

**IMPORTANT** The **Edit** button is enabled only when the **CT Threshold Method** is either **Auto (Detectors)** or **User (Detectors)**.

![Threshold Method Options](image)

### Toggle Edit

Click **Toggle Edit** in conjunction with Toggle Threshold enable moving the threshold bar to a new position by clicking and dragging it in the lower graph. This can only be done in **User Data Global** or **User Data Detector** threshold analysis methods.

![User Data Global Settings](image)

**Threshold number changes as you re-position the threshold line.**

**C_t Threshold Method can be only User Data (Global) or User (Data Detectors) for Toggle Edit to be enabled.**

## Toggle Log Graph

The log graph shows more detail of the same view of the amplification curve. Note the finer scale on the log graph $y$ axis below left.
Changing Pass/Flag

If the heat map reveals a problematic experiment, you can manually change the call to exclude the experiment. Change cells to pass or flag as appropriate. After reviewing the data, you can manually change the call to **Pass or Flag**. In the example below, the passing cell is manually set to Flag.

1. Click a cell to activate it.
2. Click the **Pass** or the **Flag** icon. Or, click **Edit > Pass** or **Edit > Flag**.

**NOTE** You can substitute the label Fail for Flag. See **Tools on page 24**.

If you used two probes, make sure the appropriate graph tab is active. In the example below, FAM-MGB and VIC-MGB probes each have a tab on the graph view. Click the appropriate graph tab before changing the call.
NOTE You can use the Call Redo or Undo buttons to revert back to the original call state.

Using the Animate Feature

In the Graph Views, watch an animation of each cell on the entire chip in sequence. Use this feature while in the Results Table, Image View, and/or Heat Map.

1. Click a cell or row.
2. Click Play and watch the Normalized Intensity and Amplification graphs as each cell is displayed in sequence.
Optional: Adjust the animation speed.

a. Click 1 fps.

b. Choose a viewing speed.

Click Stop to stop the animation.

Click Play to continue the animation.
Selecting a Single Cell

In the **Results Table**—click a cell to activate its data in the graphs and on the Information bar.

In the **Image View**—when the cursor becomes crosshairs, click the cell to activate the data in the graphs and on the Information bar.

In the **Heat Map**—click a cell to activate its data in the graphs and on the Information bar.
## Selecting More Than One Cell

Isolate data for a single cell or for multiple cells in any details view (Results Table, Image View, or Heat Map) using the following methods.

<table>
<thead>
<tr>
<th>In the Details Views Window</th>
<th>Procedure</th>
<th>Example</th>
</tr>
</thead>
</table>
| The Results Table           | Press and hold the keyboard **SHIFT** key and click the 2 outer cells for a continuous range of cells. The data for the range of cells display in the Graph Views.  
 or,  
 Press and hold the keyboard **CTRL** key while clicking individual cells. | ![Image](image1.png) |
| Image View                  | Press and hold the keyboard **CTRL** key while clicking individual cells of interest. You cannot select a contiguous range in this view. | ![Image](image2.png) |
| Heat Map                    | Click a cell and then hold and drag to highlight a range of cells.  
 Or,  
 Press and hold the keyboard **CTRL** key while clicking individual cells.  
 Or,  
 Click on the Column or Row heading and select all chambers in the column or row. | ![Image](image3.png) |
Cross Highlighting and Selecting

When you select multiple chambers, they are displayed as a line in the lower graphs.

To Cross Highlight: hover the mouse over a graph line and its chamber will be highlighted in the other graphs.

Double-clicking on the graph line selects it in the primary view and the graph view.
Using Show Dual Views

The Show Dual Views button allows you to view two primary views side-by-side, such as a Results Table View and a Heat Map View.

1. From the Details Views, click the Show Dual Views button.

2. Select which type of primary view you’d like the software to display.

3. Click Hide Dual Views to go back to only one primary view, if desired.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software
Export IFC Run Data

You can export IFC run data from the Heat Map and the Results Table views in a comma-separated value format (.csv) that can be viewed in programs such as Microsoft Excel.

**NOTE** The raw data output is used by advanced users to develop alternative analysis methods. This export option will report the fluorescence intensity values for each reaction chamber for each dye and for each PCR cycle (for real-time protocols). It includes amplification and MCA data (if the IFC run contains a melt curve protocol).

**NOTE** The comments, user calls, and Reagent Reference Count columns are not exported by default. Go to Tools > Options to enable exporting the columns that are not exported by default. (The inlet-to-well mapping positions are exported.)

1. **Click** File > Export.

2. **Enter a name for the file.**

3. **Select the type of view.** You can export data from:
   - Table results
   - Heat map view
   - Table results, with raw data

4. **Navigate to the desired folder.**
   **NOTE** By default, the file is saved in the same folder as the IFC run (.bml) file.

5. **Click** Save.

6. **To open the saved data,** navigate to the .csv file.

7. **Double-click the .csv file** to open it in a program such as Microsoft Excel.

Below is an example of exported data (Table Results) in a .csv file, opened in an Microsoft Excel spreadsheet.
Double-click between columns to expand them.

<table>
<thead>
<tr>
<th>Chip Run</th>
<th>C (Users)</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5E+09</td>
<td>24.192</td>
<td>13</td>
<td>5E 24+132</td>
<td>AOX</td>
<td>FAM-MGB</td>
<td>#1</td>
<td>1:30:44</td>
<td>FA-PROTO1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Experim Emp</th>
<th>Experim Emp</th>
<th>Experim Emp</th>
<th>Experim Emp</th>
<th>Experim Emp</th>
<th>FAM-MGB</th>
<th>FAM-MGB</th>
<th>FAM-MGB</th>
<th>FAM-MGB</th>
</tr>
</thead>
<tbody>
<tr>
<td>S13-A001 S13</td>
<td>Unknown</td>
<td>1 A001</td>
<td>Test</td>
<td>16.53167</td>
<td>1 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A002 S13</td>
<td>Unknown</td>
<td>1 A002</td>
<td>Test</td>
<td>16.44344</td>
<td>0.983338 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A003 S13</td>
<td>Unknown</td>
<td>1 A003</td>
<td>Test</td>
<td>16.48709</td>
<td>0.991712 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A006 S13</td>
<td>Unknown</td>
<td>1 A006</td>
<td>Test</td>
<td>16.496</td>
<td>1 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A005 S13</td>
<td>Unknown</td>
<td>1 A005</td>
<td>Test</td>
<td>16.37526</td>
<td>0.976326 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A004 S13</td>
<td>Unknown</td>
<td>1 A004</td>
<td>Test</td>
<td>16.43474</td>
<td>0.989769 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A013 S13</td>
<td>Unknown</td>
<td>1 A013</td>
<td>Test</td>
<td>16.46050</td>
<td>0.98921 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A014 S13</td>
<td>Unknown</td>
<td>1 A014</td>
<td>Test</td>
<td>16.3174</td>
<td>0.965962 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A015 S13</td>
<td>Unknown</td>
<td>1 A015</td>
<td>Test</td>
<td>16.24662</td>
<td>0.956842 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A018 S13</td>
<td>Unknown</td>
<td>1 A018</td>
<td>Test</td>
<td>16.49650</td>
<td>1 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A017 S13</td>
<td>Unknown</td>
<td>1 A017</td>
<td>Test</td>
<td>16.40683</td>
<td>0.98624 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A010 S13</td>
<td>Unknown</td>
<td>1 A010</td>
<td>Test</td>
<td>16.26440</td>
<td>0.959223 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A025 S13</td>
<td>Unknown</td>
<td>1 A025</td>
<td>Test</td>
<td>16.47569</td>
<td>0.985689 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A028 S13</td>
<td>Unknown</td>
<td>1 A028</td>
<td>Test</td>
<td>16.34034</td>
<td>0.976544 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A027 S13</td>
<td>Unknown</td>
<td>1 A027</td>
<td>Test</td>
<td>16.50897</td>
<td>0.999685 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A030 S13</td>
<td>Unknown</td>
<td>1 A030</td>
<td>Test</td>
<td>16.3024</td>
<td>0.96625 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A029 S13</td>
<td>Unknown</td>
<td>1 A029</td>
<td>Test</td>
<td>16.52355</td>
<td>1 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A028 S13</td>
<td>Unknown</td>
<td>1 A028</td>
<td>Test</td>
<td>16.50693</td>
<td>0.957968 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S13-A037 S13</td>
<td>Unknown</td>
<td>1 A037</td>
<td>Test</td>
<td>16.41811</td>
<td>0.999902 Pass</td>
<td>0.012402</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Opening Exported Data (.csv files)

NOTE The data looks different in the .csv file depending on the view from which you exported.

1 Double-click the saved .csv file of interest.

The exported .csv file below was saved from the Results Table view.

The exported .csv file below was saved from the Heat Map view.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Opening Exported Data (.csv files)

Real-Time PCR Analysis User Guide
Calculating Delta $C_t$ Sample Values

To calculate the delta ($\Delta$) $C_t$ samples:

1. Click **Sample Setup**.

2. Select your choice of cells where the reference sample was added.

3. Click **Editor**.

4. Click **Reference**.

5. Enter a sample name.

6. Click **Update**.

The **Sample Setup** reflects the change.
7 Select all cells that you want to reference. Typically, you select all the cells (except for the three reference cells) as in the example below.

8 Click Editor.

9 Enter a sample name.

10 Select Unknown.

11 Select the reference you created.
12 Click **Update**.

The changes are recorded as shown in the example below.

13 Click the **mapping** icon.

The **Open Sample Mapping File** dialog opens.
14 Double-click left or right mapping.
15 Click Details Views.
16 Click Analyze.

Δ Ct sample values are now available in the Results Table view.

Calculating Delta Ct Detector Values

To calculate Δ Ct detector values, follow the procedure described in the previous section, Calculating Delta Ct Sample Values on page 104.

Steps that are specific to the procedure for calculating Δ Ct detector values are described below.

- Click Detector Setup.

- Select 1 or more cells to use as a reference and select Reference in the Editor.

- Select the cells you want to reference and select Test in the Editor. You can annotate the selected cell with one reference or all of the references (if there are more than one reference detector).
The Reagent Reference Count group in the Results Table shows the number of reference detectors used to calculate the $\Delta C_t$ values.

The $\Delta C_t$ values are calculated using the average of each reference detector used for a chamber. If there are replicates for each reference detector, the delta $C_t$ is calculated as the average of the averages of each reference detector. For each reference detector selected for a test detector, the Details Views Results Table shows the following information:

<table>
<thead>
<tr>
<th>Results Table Column</th>
<th>Shows for each reference detector...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td>The total number of chambers (replicates) that correspond to each reference detector annotated in the detector setup plate.</td>
</tr>
<tr>
<td>Passed</td>
<td>Out of the &quot;Total&quot; number of chambers, how many had a $C_t$ value that passed the quality threshold (default setting is 0.65) or were manually passed.</td>
</tr>
<tr>
<td>Used</td>
<td>How many valid values were used for calculating $\Delta C_t$.</td>
</tr>
</tbody>
</table>

**NOTE**: If at least one replicate passes the quality threshold, the number of "Used" chambers equals the number of "Pass" chambers. Otherwise, the "Used" count equals the number of chambers containing a valid $C_t$ value (less than 999.0).

If you are using multiple reference detectors for a single chamber, the number of replicates for each detector are shown in the Total, Passed, and Used columns separated by commas.

The Delta $C_t$ quality score of a chamber is calculated as the minimum of the $C_t$ quality of the chamber and the quality score of the $C_t$ of the reference detectors, which is the average of the average of the "Used".

For a chamber that is manually called, the $C_t$ values used for calculating the quality score are 1 for Pass and 0 for Flag.
**Delta-Delta \( C_t \) Values**

The \( \Delta \Delta \ C_t \) values are available to you after the sample and the detector \( \Delta \ C_t \) values are calculated (see Calculating Delta Ct Detector Values on page 107 and, Calculating Delta Ct Sample Values on page 104).

When sample and detector \( \Delta \ C_t \) values have been calculated, click Details Views to see \( \Delta \Delta \ C_t \) data:

---

### Viewing Delta \( C_t \) Data in the Heat Map

In addition to viewing \( \Delta \ C_t \) and \( \Delta \Delta \ C_t \) data in the Results Table, view \( \Delta \ C_t \) data in the Heat Map.

1. Click **Details Views**.
2. Click **Analyze**, if necessary.
3. Click **Heat Map View** from the **Results Table** menu.

4. Select **FAM-MGB Delta Ct Sample** from the menu.
Chapter 3: Viewing Chip Run Data in the Data Analysis Software

Viewing Delta Ct Data in the Heat Map

Congratulations, you have successfully viewed your analyzed chip run data.
Chapter 4: Viewing Chip Run Data in the Calibration Curve View

Introduction

The Calibration Curve View Module (CCVM) (also known as “standard curve”) is a view that allows the user to create calibration curves based on the $C_t$ and known concentration differences of samples on the chip. After calibration curves are created, they are used to determine the approximate concentration of unknown samples on the chip. The approximate values are displayed in a table format.

For the CCVM to appear:

1. Open an unanalyzed chip run. See Opening an Existing Chip Run on page 28 for more information.
2. Select Details Views.
3. Click the Analyze button.
4. Select Sample Setup.
5. Click New to set up a new sample plate. Choose SBS plate or Sample Inlet for your container type. (For more detail, see Setting Up and Annotating a Sample Plate on page 32.)
6. Select a Mapping option (left- or right-side maps).
7. Use the Editor to annotate your sample cells. Make sure at least two wells are Standard type (essential for CCVM), are named, and have concentration values.
8. Set up Detector plate. For more detailed information see Setting Up and Annotating a Detector (Assay) Plate on page 42.
9. Select Details Views.
10 Click the **Analyze** button.

The Details Views item now has a plus sign in front of it.

11 Expand the plus sign (+) next to **Details Views** and the **Calibration View** option appears on the tree.

12 Select **Calibration View** to launch the CCVM page.

**CCVM Page Example**

Below is the CCVM page, which consists of five individual panes and two tool bars.
Using CCVM to Determine Concentration Levels of Unknown Samples

The objective of using CCVM is to set up a chip run with at least two standard type wells (where the concentration of DNA is known) and to predict the concentration of the unknown type samples. Four to six standard type samples are recommended. The calls of experiments that include standard samples are then plotted on the graph pane.

CCVM also allows you to modify calls associated with calibrators. This action is the same as modifying calls in the other views, but also has effect of adding or removing datapoints from the regression line (calibration curve) calculation.

When first launched, CCVM displays the contents and calibration curves of the data. These curves are created with a default fitting method (weighted linear).

1. In the Primary View Tool Bar, select a probe type, such as FAM MGB.

2. On the CCVM page, click on a detector in the Detector Table pane.

   The Detector Table displays the attributes of a detector in three columns: Name of detector, Style of fitting method and Count of Calibrators for this row.

   If detectors are named the same name, they are listed on one row in the table and the total of all calibrators are listed in the third column.

3. Adjacent to the Detector Table is a list of the calibrators applied to that detector. In the graph area below, valid detectors are plotted.

   The Calibrator Table displays six attributes of a calibrator: Name, Chamber ID, C_t value, Concentration, Error, and Call.
Chapter 4: Viewing Chip Run Data in the Calibration Curve View
Using CCVM to Determine Concentration Levels of Unknown Samples

4 Select a row in the Calibrator Table and the corresponding data point in the calibration curve becomes larger. Conversely, you can lasso or click on a data point in the chart and the corresponding row in the Calibration Table is highlighted.

**NOTE** You can lasso a point by pressing the left mouse button and dragging the mouse around the data point(s) to create a circle.

Only calibrators with valid $C_T$ values are plotted in the calibration curve. Invalid $C_T$ values are listed as 999. Calibrators that are auto or manual passed are plotted as blue dots. They are considered valid calibrators. Calibrators that are manually flagged or passed are plotted as red dots and are considered invalid calibrators. CCVM only uses blue data points to create calibration curves. If there are no valid calibrators, no calibration curve is drawn.

5 You can modify the calls by manually changing the calibrators’ calls to Pass or Flag via the secondary view tool bar.

a Select a calibrator you wish to change (you can select the row in the Calibrator Table or lasso a data point on the chart).
b Click either Pass or Flag on the secondary tool bar. Flag turns the points red. Pass turns the points blue. The corresponding calibrator in the Calibration Table changes its call accordingly and the Call column is updated.
NOTE You can use the Call Redo or Undo buttons to revert back to the original call state.

c Go to the Details Views page.

d Click the Analyze button to re-analyze the chip with these new parameters.

e The resulting calibration curve is slightly modified.

The analysis software can now use the calibration curve data to predict the approximate concentration of unknown sample types.

6 Go to the Details Views page.

7 Select the Results Table.

8 The approximate values are listed in the “Calibrated rConc” (Calibrated relative concentration) column.
Viewing Multiple Calibration Curves

You can also view multiple calibration curves at once on the CCVM page. To select multiple rows of assay in the Detector Table, Ctrl + left mouse click the rows of interest. Individual curves are rendered in the Graph Area.

Note, however, that the Calibrator Table behaves differently when multiple rows are selected in the Detector Table. The Calibrator Table is masked gray and the user cannot perform any actions on it. This is because the Calibrator Table was designed to only show calibrators for one detector at a time.
Chapter 5: qPCR + Melting Curve Analysis

Introduction to qPCR + MCA Chip Runs

When a DNA binding dye is used for detecting PCR products, the products of the reaction can be analyzed by following the run with melt curve analysis (MCA).

This chapter provides a brief overview for when you analyze a chip run that has been run with a qPCR+MCA protocol.

The protocol must have one PCR segment that is before one Melting Curve segment. This applies to any real-time chip type.

By running a Melting Curve segment after the PCR segment, the T_m data is generated and used to validate the C_T curves of the PCR segment. The software detects up to two T_m peaks, one in a user-defined range and one outside it.

Running a Chip with a qPCR + MCA Protocol

When you run a chip with a qPCR and MCA protocol, the T_m peak detected inside the T_m detection range validates the amplification curve of the PCR cycle. If no T_m peak is detected, then any amplification that may exist is not considered valid and the quality of the C_T is set to zero (0), making the chamber Fail.

You analyze data by clicking the Analyze button.
The Tm Ranges

The Tm peak detection range is set for each detector. By default, each detector range is the temperature range of the protocol.

To identify the temperature range in which you expect to see a Tm peak, select a region of the temperature range. A Tm peak in range validates the Ct curve and a Tm peak outside of range invalidates it, failing the chamber.

The MCA tab allows you change these parameters:

- **Peak Sensitivity** – adjust how sensitive the algorithm is for detecting a peak, with 1 being the least sensitive and 10 being the most sensitive.

- **Peak Ratio Threshold** – determine if a peak outside of range should cause the chamber to fail when multiple peaks are detected (one in range and one out of range)

- **Tm Ranges** – adjust the detection range for each detector.

![MCA Tab](image)

Viewing the Tm Ranges

Toggle the **Threshold** button to display the Tm detection range (light blue).

![Tm Ranges Graph](image)

Editing the Tm Ranges

Toggle the **Threshold / Edit** button to display the MCA tab and directly change the Tm ranges for each detector.

You can also click and drag the Tm ranges.
Working with Views

There are three views:

- Results Table
- Heat Map
- Graph

Results Table View

A $T_m$ section appears for each probe type. The first column is the value for the $T_m$ peak detected in range. The second column is the value for the out of range $T_m$ peak. A value of 999 means no peak was detected.

<table>
<thead>
<tr>
<th>$T_m$</th>
<th>In Range</th>
<th>Out Range</th>
<th>Peak Ratio</th>
<th>Peak Call</th>
</tr>
</thead>
<tbody>
<tr>
<td>71.39</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>74.20</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>74.73</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>82.03</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>82.39</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>80.26</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>79.94</td>
<td>999.00</td>
<td>1.00</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Heat Map View

For MCA runs, there are two additional data views: Inside $T_m$ and Outside $T_m$. Also, the spectrum is adjusted for $T_m$ values.

Graph View

In this view, there are two layouts: Combined and Tabbed.

the Combined view shows the visible Amplification ($C_T$) and Melting ($T_m$) graphs.
The **Tabbed** view has two tabs of graphs for each probe type defined in the chip run: **qPCR** and **MCA**.

The **qPCR** tab shows Normalized Intensity (PCR) and Amplification.

The **MCA** tab shows graphs for Normalized Intensity (MCA) and Melting.

**The Melting Graph**

The **Melting** graph displays the $T_m$ curve for the selected chambers. A green vertical line represents a $T_m$ peak inside the $T_m$ detection range.
A black vertical line represents a $T_m$ peak detected outside the $T_m$ detection range.

**Exporting Data**

CSV Table data -- includes the $T_m$ columns from the Table View.

CSV Heat Map data -- includes visible data in the heat map ($C_t$, Inside $T_m$, Outside $T_m$).
Appendix A: cDNA Preparation with Reverse Transcription Master Mix

Reverse Transcription Master Mix is a 5X master mix containing all the components required for cDNA synthesis, including buffer, dNTPs, primers, a ribonuclease inhibitor, and an engineered RNaseH+ MMLV reverse transcriptase. A mixture of random primers and oligo dT is used for priming. The cDNA prepared using the Reverse Transcription Master Mix is suitable for preamplification using Preamp Master Mix.

The range of total RNA that can be used in a 5 μL reverse transcription reaction is 2.5 pg to 250 ng. However, the success with a given sample in qPCR depends on the level of gene expression for the genes of interest, the percentage of mRNA in the total RNA, and the number of cycles of preamplification performed prior to qPCR. In general, for total RNA input in the range of 2 ng to 250 ng, 10–14 cycles of preamplification should be sufficient. For a total RNA input less than 2 ng, increasing the number of preamplification cycles to 18–20 may improve performance.

Prepare RT Reactions

1. Thaw all reagents on ice. Briefly vortex and centrifuge the reagents before using.

2. On ice, prepare a pre-mix of the Reverse Transcription Master Mix and water as indicated in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Reaction (μL)</th>
<th>Volume for 48 Reactions* (μL)</th>
<th>Volume for 96 Reactions* (μL)</th>
<th>Volume for 192 Reactions* (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Transcription Master Mix</td>
<td>1.0</td>
<td>52.8</td>
<td>105.6</td>
<td>211.2</td>
</tr>
<tr>
<td>(100-6297)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RNase-free water</td>
<td>3.0</td>
<td>158.4</td>
<td>316.8</td>
<td>633.6</td>
</tr>
<tr>
<td>RNA (2.5 pg/μL–250 ng/μL)</td>
<td>1.0</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Total</td>
<td>5.0</td>
<td>211.2</td>
<td>422.4</td>
<td>844.8</td>
</tr>
</tbody>
</table>

* Includes 10% overage for ease of pipetting.

3. In a PCR plate (on ice), aliquot 4 μL of pre-mix for each sample.

4. Add 1 μL of RNA to each well containing pre-mix, making a total volume of 5 μL.

5. Properly seal and gently vortex to mix the reverse transcription reactions.

6. Centrifuge the reactions and place in a standard thermal cycler.
Appendix A: cDNA Preparation with Reverse Transcription Master Mix

Thermal-Cycle

In a thermal cycler, incubate using the following protocol:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>+25 °C</td>
<td>5 min</td>
<td>Reverse transcription</td>
</tr>
<tr>
<td>+42 °C</td>
<td>30 min</td>
<td></td>
</tr>
<tr>
<td>+85 °C</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>+4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

After the reverse transcription reaction is complete, the reactions can be stored at −20 °C or used immediately for preamplification reactions with Preamp Master Mix.

The cDNA prepared with Reverse Transcription Master Mix can be used in preamplification with either TaqMan® Gene Expression Assays or Delta Gene™ assays. You can use up to 1.25 μL of the reaction in a 5 μL preamplification reaction.
Appendix B: Fast Gene Expression Analysis Using EvaGreen on Biomark or Biomark HD

The use of DNA binding dyes for gene expression analysis is a lower cost alternative to the use of labeled probes. The method is sensitive and when coupled with melt curve analysis the specificity of the primers can be confirmed. For this protocol we are recommending the use of EvaGreen® dye, which has several advantages over SYBR® Green I (1, 2). This document provides a fast cycling protocol that can be used on either the Biomark™ HD with fast ramp rates (5.5ºC/s) or the Biomark with the normal ramp rate (2ºC/s). This protocol can be used with the 48.48 Dynamic Array™ integrated fluidic circuit (IFC), 96.96 Dynamic Array™ IFC, and the 192.24 Gene Expression IFC.

NOTE This appendix only specifies reagent prep for the 48.48 Dynamic Array™ IFC and the 96.96 Dynamic Array™ IFC. When using a 192.24 Gene Expression IFC, refer to the Fluidigm 192.24 Delta Gene™ Fast/Standard Gene Expression Workflow (PN 100-7222).

The use of the fast ramp rate on the Biomark HD System requires the use of a PCR master mix that has been optimized for fast cycling. The fast master mix recommended for use in this protocol includes both EvaGreen® and ROX in the master mix, which makes it convenient to use. This master mix also works well on the Biomark System with the normal ramp of 2ºC/s. The total cycling time on the Biomark System will be longer than the cycling time on the Biomark HD System, but still faster than standard protocols.

Primers need to be designed to reduce the potential for primer dimer formation and to be highly specific for the target of interest. For the development of this protocol, we used Delta Gene™ Assays, a set of assays designed by the Assay Design Group at Fluidigm which avoid SNPs and are highly specific for the gene of interest.

We recommend preamplification to increase the number of copies of target DNA. Prior to qPCR reactions the preamplification reaction is treated with Exonuclease I to eliminate the carryover of unincorporated primers.

References

1 SsoFast™ EvaGreen® Supermix With Low ROX product literature (http://www.bio-rad.com)

Appendix B: Fast Gene Expression Analysis Using EvaGreen on Biomark or Biomark HD

Materials

Required Reagents

**IMPORTANT** Store reagents as soon as they are received, according to manufacturer’s storage recommendations.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Assay Loading Reagent</td>
<td></td>
<td>85000736</td>
</tr>
<tr>
<td>20X DNA Binding Dye Sample Loading Reagent</td>
<td></td>
<td>100-3738</td>
</tr>
<tr>
<td>PreAmp Master Mix</td>
<td>Fluidigm</td>
<td></td>
</tr>
<tr>
<td>100 μM each Forward and Reverse Primer Stock Mixture for each assay of interest:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SsoFast™ EvaGreen® Supermix with Low ROX</td>
<td>Bio-Rad Laboratories</td>
<td>172-5211</td>
</tr>
<tr>
<td>Exonuclease I</td>
<td>New England BioLabs</td>
<td>M0293L</td>
</tr>
<tr>
<td>DNA Suspension Buffer</td>
<td>Teknova</td>
<td>T0021</td>
</tr>
<tr>
<td>PCR Certified Water</td>
<td></td>
<td>W3330</td>
</tr>
<tr>
<td>TE Buffer (10 mM Tris, pH 8.0, 1.0 mM EDTA)</td>
<td></td>
<td>T0221</td>
</tr>
</tbody>
</table>

Required Consumables

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear adhesive film</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>96-well PCR plates</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Microcentrifuge tubes, 1.5 mL</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>8-well PCR tube strips</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>
Required Equipment

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark™ HD system</td>
<td>Fluidigm</td>
<td>BMKHD-BMKHD or BMK-BMK</td>
</tr>
<tr>
<td>Biomark system</td>
<td>Fluidigm</td>
<td>101-6455 or IFC-MX or IFC-HX</td>
</tr>
<tr>
<td>Juno™ system or IFC Controller MX (48.48 Dynamic Array IFCs) or IFC Controller HX (96.96 Dynamic Array IFCs)</td>
<td>Fluidigm</td>
<td>101-6115 or 101-6116</td>
</tr>
<tr>
<td>If using Juno: MX Interface Plate (48.48 Dynamic Array IFCs) or HX Interface Plate (96.96 Dynamic Array IFCs)</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>2 centrifuges: 1 for microtubes, 1 for 96-well PCR plates</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Pipettes (P2–P1000) and appropriate filtered, low-retention tips</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>8-channel pipettes and appropriate filtered, low-retention tips</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Vortexer</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Thermal cycler for 96-well plates</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Software Requirements

The following software is required for this protocol:

- Fluidigm® Real-Time PCR Analysis Software v.3.0.2 or later
- Biomark™ HD Data Collection Software v.3.1.2 or later
Gene Expression PreAmp with Fluidigm PreAmp Master Mix and Delta Gene Assays

In the Biomark HD System, samples are loaded into individual inlets and then distributed across multiple reaction chambers in nanoliter volume aliquots. With these small volumes, detecting the specific targets requires a minimum of 800 copies/μL in the final sample mix. For genes with lower expression levels, there are too few copies to detect adequately in cDNA samples. Preamplification is used to increase the number of copies to a detectable level for a greater number of genes.

Preamplification allows for multiplex amplification of up to 96 targets. A pool of primers is prepared from the same gene expression assays to be used for qPCR. By using the real-time qPCR assays in the preamplification reaction, only the targets of interest are amplified. A limited number of cycles is used, generally 10-14. Under these conditions of low primer concentration and a limited number of cycles, the cDNA is amplified without significant bias for the majority of genes.

Pooling the Delta Gene Assays

1. In a microcentrifuge tube, combine 1 μL of each 100 μM stock Delta Gene Assay, up to a total of 96 assays.

2. Add DNA Suspension Buffer (10 mM Tris, pH 8.0, 0.1 mM EDTA; TEKnova, PN T0221) to make the final volume 200 μL. The concentration of each assay will be 500 nM.

**NOTE** Volume can be adjusted proportionally based on the number of samples to be amplified.

Preparing Sample Pre-Mix and Samples

1. In a DNA-free hood, prepare a Pre-Mix for the reactions as indicated in the table below:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume / Reaction (μL)</th>
<th>Volume for 48 Reactions + 10% Overage (μL)</th>
<th>Volume for 96 Reactions + 10% Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRE-MIX</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PreAmp Master Mix</td>
<td>1.00</td>
<td>52.8</td>
<td>105.6</td>
</tr>
<tr>
<td>Pooled Delta Gene Assay Mix (500 nM)</td>
<td>0.50</td>
<td>26.4</td>
<td>52.8</td>
</tr>
<tr>
<td>Water</td>
<td>2.25</td>
<td>118.8</td>
<td>237.6</td>
</tr>
<tr>
<td>cDNA</td>
<td>1.25</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>5.00</strong></td>
<td><strong>—</strong></td>
<td><strong>—</strong></td>
</tr>
</tbody>
</table>

2. In a PCR plate, aliquot 3.75 μL of Pre-Mix for each sample.
3 Remove the plate from the DNA-free hood and add 1.25 μL of cDNA to each well containing Pre-Mix, making a total volume of 5 μL.

4 Mix the reactions by briefly vortexing, then centrifuge.

**Thermal Cycling**

1 Place the plate in the thermal cycler and cycle using the following table as a guide:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>2 min</td>
<td>Hold</td>
</tr>
<tr>
<td>95 °C</td>
<td>15 sec</td>
<td>10 cycles</td>
</tr>
<tr>
<td>60 °C</td>
<td>4 min</td>
<td>Annealing/Extension</td>
</tr>
<tr>
<td>4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

**NOTE** Ten (10) cycles are recommended as a starting point, but this number can be increased up to 20 cycles, if necessary. The appropriate number of cycles should be determined empirically.

**Exonuclease I Treatment to Remove Unincorporated Primers**

1 Dilute the Exonuclease I to 4U/μL as shown below:

<table>
<thead>
<tr>
<th>Component</th>
<th>Per 5 μL Sample (μL)</th>
<th>48 Samples with Overage (μL)</th>
<th>96 Samples with Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>1.4</td>
<td>84.0</td>
<td>168.0</td>
</tr>
<tr>
<td>Exonuclease I Reaction Buffer (10X) *</td>
<td>0.2</td>
<td>12.0</td>
<td>24.0</td>
</tr>
<tr>
<td>Exonuclease I at 20 units/μL</td>
<td>0.4</td>
<td>24.0</td>
<td>48.0</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>2.0</strong></td>
<td><strong>120.0</strong></td>
<td><strong>240.0</strong></td>
</tr>
</tbody>
</table>

* Exonuclease I and buffer from New England BioLabs, PN M0293S or PN M0293L

2 Add 2 μL of diluted Exonuclease I at 4 U/μL to each preamplification reaction, vortex, centrifuge, place in a thermal cycler, and incubate with the following program:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>37 °C</td>
<td>30 min</td>
<td>Digest</td>
</tr>
<tr>
<td>80 °C</td>
<td>15 min</td>
<td>Inactivate</td>
</tr>
<tr>
<td>4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

3 Dilute the final products in TE Buffer (10 mM Tris-HCl, 1.0 mM EDTA, TEKnova, PN T0221) as shown in the table below:
NOTE Diluted reaction products can either be assayed immediately or stored at -20°C for later use. Diluted reaction products should be stable for at least one week..

Preparation of Sample Pre-Mix and Samples

The following protocol only specifies reagent prep for the 48.48 Dynamic Array™ IFC and the 96.96 Dynamic Array™ IFC.

When using a 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference (100-7222).

1. Prepare the Sample Pre-Mix as shown below:

   **Table 2. Sample Pre-Mix solution**

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (µL)</th>
<th>Volume per Inlet with Overage (µL)</th>
<th>Volume for 48.48 Dynamic Array IFC (µL)</th>
<th>Volume for 96.96 Dynamic Array IFC (µL)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRE-MIX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2X SsoFast EvaGreen Supermix</td>
<td>2.5</td>
<td>3.0</td>
<td>180.0</td>
<td>360.0</td>
</tr>
<tr>
<td>With Low ROX (Bio-Rad Laboratories, 172-5211)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20X DNA Binding Dye Sample Loading Reagent (100-3738)</td>
<td>0.25</td>
<td>0.3</td>
<td>18.0</td>
<td>36.0</td>
</tr>
<tr>
<td>PreAmp and Exo I-treated sample</td>
<td>2.25</td>
<td>2.7</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Total</td>
<td><strong>5.0</strong></td>
<td><strong>6.0</strong></td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

   * 60 samples for ease of pipetting
   † 120 samples for ease of pipetting

2. Aliquot 3.3 µL of Pre-Mix for each sample and add 2.7 µL of PreAmp and Exo I-treated sample.

3. Vortex the Sample Mix solution for a minimum of 20 seconds, and centrifuge for at least 30 seconds. Prepared reactions can be stored for short times at 4°C until the samples are ready to be loaded into the chip.

**IMPORTANT** Use caution when pipetting the 20X DNA Binding Dye Sample Loading Reagent as bubbles can be introduced.
Preparing the Assay Mix

The following protocol only specifies reagent prep for the 48.48 Dynamic Array™ IFC and the 96.96 Dynamic Array™ IFC.

When using a 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference (100-7222).

1 Dilute the 100 μM stocks of combined Forward and Reverse Primers for each assay to a final concentration of 5 μM as shown:

Table 3. Assay mix solutions

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume per 50 μL Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Assay Loading Reagent</td>
<td>2.5</td>
<td>3.0</td>
<td>25</td>
</tr>
<tr>
<td>1X DNA Suspension Buffer</td>
<td>2.25</td>
<td>2.7</td>
<td>22.5</td>
</tr>
<tr>
<td>100 μM each mixed Forward and Reverse Primers</td>
<td>0.25</td>
<td>0.3</td>
<td>2.5</td>
</tr>
<tr>
<td>Total Volume</td>
<td>5</td>
<td>6</td>
<td>50</td>
</tr>
</tbody>
</table>

2 Vortex the Assay Mix for a minimum of 20 seconds, and centrifuge for at least 30 seconds to spin down all components.

**IMPORTANT** Vortex thoroughly and centrifuge all sample and assay solutions before pipetting into the chip inlets. Failure to do so may result in a decrease in data quality.

**NOTE** The final concentration of each primer is 5 μM in the inlet and 500 nM in the final reaction.

Priming the IFC and Loading Assay and Samples

For instructions on priming and loading the 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference (100-7222).

For detailed instructions for injecting control line fluid, see the Control Line Fluid Loading Procedure Quick Reference (68000132).

For detailed instructions about using Juno, see the Juno System User Guide (100-7070). For detailed instructions about using the IFC Controller MX, see the IFC Controller MX and IFC Controller HX User Guide (68000112).

**IMPORTANT** Due to different accumulator volumes, use the appropriate control line fluid syringe for the IFC type:
- For 48.48 IFCs, only use a syringe prefilled with 300 μL of control line fluid (89000020).
- For 96.96 IFCs, only use a syringe prefilled with 150 μL of control line fluid (89000021).

1 If using Juno, ensure that the MX Interface Plate (48.48 IFCs) or the HX Interface Plate (96.96 IFCs) is installed in the Juno instrument.

2 Inject control line fluid into each accumulator on the chip (see Figure 1 for the 48.48 Dynamic Array IFC or Figure 2 for the 96.96 Dynamic Array IFC).
3 Remove and discard the protective film from the bottom of the IFC.

4 Place the IFC into the controller:
   - Juno: Tap **OPEN** to open the instrument tray and align the notched corner of the IFC to the white notch on the tray. Tap **LOAD**.
   - MX or HX: Press **EJECT** to open the instrument tray and align the notched corner of the IFC to the A1 mark. Press **Load Chip**.

5 Run the Prime script:
   - Juno: Tap **Prime 48.48 GE** (48.48 IFCs) or **Prime 96.96 GE** (96.96 IFCs), then tap **Run**.
   - MX (48.48 IFCs): Select **Prime (113x)** and press **Run Script**.
   - HX (96.96 IFCs): Select **Prime (136x)** and press **Run Script**.

**IMPORTANT** Load the IFC within 1 hr of completing the Prime script.
Load the IFC

**IMPORTANT**
- Vortex thoroughly and centrifuge all final sample and assay mixes before pipetting into the IFC inlets. Failure to do so may result in a decrease in data quality.
- While pipetting, do not go past the first stop on the pipette. Doing so may introduce air bubbles into inlets.

Refer to Figure 2 when pipetting sample and assay mixes into the IFC.

1. After the prime script is finished, remove the primed IFC from the controller.
2. Pipet 5 μL of each sample mix into the respective sample inlets on the IFC.
3. Pipet 5 μL of each assay mix into the respective assay inlets on the IFC.
4. Place the IFC into the controller:
   - Juno: Tap **OPEN** to open the instrument tray and align the notched corner of the IFC to the white notch on the tray. Tap **LOAD**.
   - MX or HX: Press **EJECT** to open the instrument tray and align the notched corner of the IFC to the A1 mark. Press **Load Chip**.
5. Run the Load Mix script:
   - Juno: Tap **Load Mix 48.48 GE** (48.48 IFCs) or **Load Mix 96.96 GE** (96.96 IFCs), then tap **Run**.
   - MX (48.48 IFCs): Select **Load Mix (113x)** and press **Run Script**.
   - HX (96.96 IFCs): Select **Load Mix (136x)** and press **Run Script**.

**IMPORTANT** If necessary, turn on the Biomark HD or Biomark system (computer and instrument). For Biomark, also launch the Data Collection software, and turn on the lamp. The lamp takes 20 min to warm up.

![Figure 2. Pipetting maps for the 48.48 and 96.96 IFCs](image-url)
Thermal-Cycle and Collect Real-Time PCR Data

For detailed instructions about using the Data Collection software, see the Biomark HD Data Collection User Guide (100-2451).

1. Remove the loaded IFC from Juno or IFC Controller RX.
2. Use clear tape to remove any dust particles or debris from the IFC surface if necessary.
3. If necessary, double-click the Data Collection icon ( ) on the desktop of the Biomark HD computer to launch the software.
4. Click Start a New Run.
5. Confirm that the camera status indicator at the bottom of the window is green.
6. Place the loaded IFC on the instrument tray and align the notched A1 corner on the IFC with the A1 label on the tray. In the Data Collection software, click Load.
7. Confirm the IFC barcode and IFC type and then click Next.
8. Complete the Chip Run section by selecting either a new or a pre-defined run.
    
    NOTE To pre-define a run, see the Biomark HD Data Collection User Guide
9. Complete the Chip Run Name and Location section:
   a. Enter a run name or select the checkbox to use the IFC barcode as the run name.
   b. Select a file storage location for a new IFC run and click Next.
10. Complete the Application, Reference and Probes section and then click Next.

<table>
<thead>
<tr>
<th>For</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Gene Expression</td>
</tr>
<tr>
<td>Passive reference</td>
<td>ROX™</td>
</tr>
<tr>
<td>Assay</td>
<td>Single probe</td>
</tr>
<tr>
<td>Probes</td>
<td>EvaGreen</td>
</tr>
</tbody>
</table>

11. Browse to and select the thermal protocol:

<table>
<thead>
<tr>
<th>For</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark HD</td>
<td></td>
</tr>
<tr>
<td>• 48.48 IFC</td>
<td>GE Fast 48x48 PCR+Melt v2.pcl</td>
</tr>
<tr>
<td>• 96.96 IFC</td>
<td>GE Fast 96x96 PCR+Melt v2.pcl</td>
</tr>
<tr>
<td>Biomark</td>
<td></td>
</tr>
<tr>
<td>• 48.48 IFC</td>
<td>GE 48x48 PCR+Melt v2.pcl</td>
</tr>
<tr>
<td>• 96.96 IFC</td>
<td>GE 96x96 PCR+Melt v2.pcl</td>
</tr>
</tbody>
</table>

NOTE For a description of the thermal protocols, see page 135.

12. Confirm that Auto Exposure is selected. Click Next.
13. Confirm that IFC run information is correct and click Start Run.
14. After the run is complete, analyze your data using the Real-Time PCR Analysis software.
Using the Real-Time PCR Analysis Parameters

1. Double-click the Real-Time PCR Analysis icon on the desktop to launch the Real-Time PCR Analysis software.

2. Click (Open), then browse to and select the chiprun.bml file to open it in the Real-Time PCR Analysis software.

3. Enter the detector and sample information.

4. Click Details Views. We recommend using the following Analysis Settings, .

<table>
<thead>
<tr>
<th>For</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline Correction</td>
<td>Linear Derivative</td>
</tr>
<tr>
<td>Ct Threshold Method</td>
<td>Auto (Global)</td>
</tr>
</tbody>
</table>

5. Always compare the Tm of the intended products to a positive control sample.

6. Click Analyze to analyze the IFC run.

Thermal Cycler Protocols

Fast Protocols

GE Fast 48x48 PCR+Melt v2 thermal cycling parameters (for Biomark HD only)

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>3 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>

GE Fast 96x96 PCR+Melt v2 thermal cycling parameters (for Biomark HD only)

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C</td>
<td>2400 sec</td>
<td>Thermal mix</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>30 sec</td>
<td></td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>3 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>

Standard Protocols

GE 48x48 PCR+Melt v2 thermal cycling parameters
<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>3 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>

**GE 96x96 PCR+Melt v2 thermal cycling parameters**

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C</td>
<td>2400 sec</td>
<td>Thermal mix</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>30 sec</td>
<td></td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>3 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>
Appendix C: Two-Step Single-Cell Gene Expression Using EvaGreen Supermix on the Biomark and Biomark HD Systems

This protocol includes a separate reverse transcription step and a specific target amplification (STA) step, hence its “two-step” title. The following protocol enables the use of a DNA binding dye for quantitative PCR gene expression. DNA binding dyes offer flexibility at a very low upfront cost relative to probe-based assays, and can be used for a variety of applications. This specific protocol has been tested for gene expression targeting 1 and 10 cells on the Biomark™ and Biomark™ HD System and should serve only as a guideline for any customers interested in qPCR dye experiments. We recommend examining melting curve (Tₘ) and C_q for all assays alongside a positive control sample.

The protocol involves performing Specific Target Amplification (STA), which enriches samples for loci of interest. STA retains relative abundance between loci and permits quantitative C_q information to be derived. See Devonshire et al. BMC Genomics 2011, 12:118 for more information on STA (preamplification). Quantitative PCR is then performed in the presence of a DNA binding dye, known as EvaGreen® dye. Quantitative PCR thermal cycling protocols are immediately followed by acquisition of a melting curve (Tₘ) to allow assessment of reaction quality. See Mao et al., BMC Biotechnology 2007, 7:76, for further information on the physicochemical properties of EvaGreen dye.

This two-step protocol is optimized for both the Biomark™ and Biomark™ HD systems. It includes a fast master mix and a relatively short qPCR protocol. We have validated a supermix that has EvaGreen® and ROX already incorporated. The protocol also uses a 2-step VILO™ cDNA synthesis kit.
Materials

Required Reagents

**IMPORTANT** Store reagents as soon as they are received, according to manufacturer’s storage recommendations.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Assay Loading Reagent</td>
<td>Fluidigm</td>
<td>85000736</td>
</tr>
<tr>
<td>20X DNA Binding Dye Sample Loading Reagent</td>
<td></td>
<td>100-3738</td>
</tr>
<tr>
<td>SsoFast™ EvaGreen® Supermix with Low ROX</td>
<td>Bio-Rad Laboratories</td>
<td>172-5211</td>
</tr>
<tr>
<td>Exonuclease I</td>
<td>New England BioLabs</td>
<td>M0293S (3,000 units)</td>
</tr>
<tr>
<td>T4 Gene 32 Protein</td>
<td></td>
<td>M0293L (15,000 units)</td>
</tr>
<tr>
<td>DNA Suspension Buffer (10 mM Tris, pH 8.0, 0.1 mM EDTA)</td>
<td>Teknova</td>
<td>T0221</td>
</tr>
<tr>
<td>Nuclease-free Water</td>
<td></td>
<td>W3330</td>
</tr>
<tr>
<td>NP-40 Detergent Surfact-Amps Solution</td>
<td>Fisher Scientific</td>
<td>PI-28324</td>
</tr>
<tr>
<td>0.5M EDTA, pH 8.0</td>
<td>Thermo Fisher Scientific</td>
<td>28324</td>
</tr>
<tr>
<td>SUPERase-In™ RNase Inhibitor</td>
<td>Thermo Fisher Scientific</td>
<td>Am9260G</td>
</tr>
<tr>
<td>SuperScript® VILO™ cDNA Synthesis Kit</td>
<td></td>
<td>AM2696</td>
</tr>
<tr>
<td>TaqMan® PreAmp Master Mix</td>
<td></td>
<td>11754-250</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4391128</td>
</tr>
</tbody>
</table>

Required Consumables

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear adhesive film</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>96-well PCR plates</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Microcentrifuge tubes, 1.5 mL</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>8-well PCR tube strips</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>
Appendix C: Two-Step Single-Cell Gene Expression Using EvaGreen Supermix on the Biomark and Biomark HD Systems

Required Equipment

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark™ HD system or Biomark system</td>
<td></td>
<td>BMKHD-BMKHD or BMK-BMK</td>
</tr>
<tr>
<td>Juno™ system or IFC Controller MX (48.48 Dynamic Array IFCs) or IFC Controller HX (96.96 Dynamic Array IFCs) or IFC Controller RX (192.24 Dynamic Array IFCs)</td>
<td>Fluidigm</td>
<td>101-6455 or IFC-MX or IFC-HX or IFC-RX</td>
</tr>
<tr>
<td>If using Juno:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MX Interface Plate (48.48 Dynamic Array IFCs) or HX Interface Plate (96.96 Dynamic Array IFCs) or RX Interface Plate (192.24 Dynamic Array IFCs)</td>
<td></td>
<td>101-6115 or 101-6116 or 101-6114</td>
</tr>
<tr>
<td>2 centrifuges:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 for microtubes, 1 for 96-well PCR plates</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pipettes (P2–P1000) and appropriate filtered, low-retention tips</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8-channel pipettes and appropriate filtered, low-retention tips</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vortexer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermal cycler for 96-well plates</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Software Requirements

The following software is required for this protocol:

- Fluidigm® Real-Time PCR Analysis Software v.3.1.3 or later
- Biomark™ HD Data Collection Software v.3.1.2 or later

NOTE For earlier versions, contact Technical Support.

Preparing the Reverse Transcription (RT) Reaction Assembly

1 For each well of a 96-well plate that will be used for sorting, prepare RT mix solution.

Table 1. RT mix solution 1

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (μL)</th>
<th>48 Samples with Overage (μL)</th>
<th>96 Samples with Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5X VILO™ Reaction Mix</td>
<td>1.2</td>
<td>72.0</td>
<td>144.0</td>
</tr>
<tr>
<td>20U/μL SUPERase-In™</td>
<td>0.3</td>
<td>18.0</td>
<td>36.0</td>
</tr>
<tr>
<td>10% NP40</td>
<td>0.25</td>
<td>15.0</td>
<td>30.0</td>
</tr>
<tr>
<td>Nuclease-free Water</td>
<td>3.25</td>
<td>195.0</td>
<td>390.0</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>5.0</strong></td>
<td><strong>300.0</strong></td>
<td><strong>600.0</strong></td>
</tr>
</tbody>
</table>
2 Pipette 5 μL of RT Mix Solution 1 into each well to be used of the 96-well PCR plate.

3 Sort individual cells or sort up to 10 cells directly into the same plate containing RT Mix Solution 1.

4 Sort cells into the same 96-well plate that will be used for thermal cycling.

5 Seal the plate and vortex thoroughly for 15 seconds.

6 Pre-chill centrifuge to 4ºC.

7 Centrifuge plate briefly at 4ºC.

8 Immediately freeze the plate on dry ice.

9 Store plate at -80ºC or thaw plate to use immediately.

**Denaturation of RNA**

1 When you are ready to perform RT cycling:
   a Thaw samples on ice.
   b Use a pre-chilled centrifuge maintained at 4ºC to spin the plate briefly.
   c Preheat thermal cycler to 65ºC.
   d Transfer the samples to the thermal cycler.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>65 ºC</td>
<td>90 sec</td>
<td>Denature</td>
</tr>
</tbody>
</table>

2 Snap chill the plate on ice immediately for 5 minutes and centrifuge briefly at 4 ºC.

3 Prepare enough RT Mix Solution 2 for all sorted wells, according to the table below.

   **Table 2. RT Mix Solution 2**

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (μL)</th>
<th>48 Samples with Overage (μL)</th>
<th>96 Samples with Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10X SuperScript® Enzyme Mix</td>
<td>0.15</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>T4 Gene 32 Protein</td>
<td>0.12</td>
<td>7.2</td>
<td>14.4</td>
</tr>
<tr>
<td>Nuclease-free Water</td>
<td>0.73</td>
<td>43.8</td>
<td>87.6</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1.00</strong></td>
<td><strong>60.0</strong></td>
<td><strong>120.0</strong></td>
</tr>
</tbody>
</table>

4 Aliquot 1 μL into each of the wells and centrifuge briefly at 4 ºC.
RT Cycling

1. Follow the thermal cycling conditions below on a standard thermal cycler:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 °C</td>
<td>5 min</td>
<td>Reverse transcription</td>
</tr>
<tr>
<td>50 °C</td>
<td>30 min</td>
<td></td>
</tr>
<tr>
<td>55 °C</td>
<td>25 min</td>
<td></td>
</tr>
<tr>
<td>60 °C</td>
<td>5 min</td>
<td></td>
</tr>
<tr>
<td>70 °C</td>
<td>10 min</td>
<td></td>
</tr>
<tr>
<td>4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

2. Centrifuge and store the first strand cDNA samples at -20°C or proceed directly to PCR.

Preparing 10X STA Primer Mix

1. We recommend using Delta Gene™ Assays from Fluidigm. These assays come as a Forward and Reverse primer mix with each primer at a concentration of 100 μM.

   **NOTE** If you obtain primers from another source, combine the Forward primer and Reverse primer for each assay so that the concentration of each primer is 100 μM. Proceed to step 2.

2. In a DNA-free hood, combine equal volumes of each 100 μM primer pair.

3. Dilute using 1X DNA Suspension Buffer so that each primer is at a final concentration of 500 nM. This mix represents a 10X concentration of pooled STA Primer Mix.

4. Vortex for 20 seconds and centrifuge for 30 seconds to spin down all components.

5. Store 10X STA Primer Mix at 4°C for repeated usage up to six months or store at -20°C for long-term storage.

<table>
<thead>
<tr>
<th>48 Primer Pairs (EXAMPLE)</th>
<th>Volume (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 μL each primer pair (100 μM each)</td>
<td>1 μL x 48 = 48 μL</td>
</tr>
<tr>
<td>1X DNA Suspension Buffer</td>
<td>152 μL</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>200</strong></td>
</tr>
</tbody>
</table>
Preparing STA Reaction Mix

1 For each well of a 96-well PCR plate that was used for sorting, prepare the following mix.

Table 4. STA Reaction Mix

<table>
<thead>
<tr>
<th>Component</th>
<th>Per 9 μL Sample (μL)</th>
<th>48 Samples with Overage (μL)</th>
<th>96 Samples with Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® PreAmp Master Mix (Thermo Fisher Scientific, 4391128)</td>
<td>7.5</td>
<td>390.0</td>
<td>780.0</td>
</tr>
<tr>
<td>10X STA Primer Mix (500 nM)</td>
<td>1.5</td>
<td>78.0</td>
<td>156.0</td>
</tr>
<tr>
<td>0.5M EDTA, pH 8.0 (Thermo Fisher Scientific, AM9260G)</td>
<td>0.075</td>
<td>3.90</td>
<td>7.80</td>
</tr>
</tbody>
</table>

Total Volume 9.0 471.9 943.8

1 Aliquot 9 μL of the STA reaction mix to each of the first strand cDNA samples.

STA Cycling

Follow the thermal cycling conditions below on a standard thermal cycler.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>10 min</td>
<td>Enzyme Activation</td>
</tr>
<tr>
<td>96 °C 5 sec</td>
<td>20 cycles</td>
<td>Denaturation</td>
</tr>
<tr>
<td>60 °C 4 min</td>
<td>1-10 cells</td>
<td>Annealing/Extension</td>
</tr>
<tr>
<td>4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

Exonuclease I (Exo I) Treatment Method

For best results, we recommend using a cleanup step to remove unincorporated primers. This can be done with Exonuclease I (E.coli).

1 Just before use, dilute the Exonuclease I to 4U/μL as shown:

Table 5. Exo I Reaction Solution

<table>
<thead>
<tr>
<th>Component</th>
<th>Per 15 μL Sample (μL)</th>
<th>48 Samples with Overage (μL)</th>
<th>96 Samples with Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>4.2</td>
<td>252.0</td>
<td>504.0</td>
</tr>
<tr>
<td>Exonuclease I Reaction Buffer (10X)</td>
<td>0.6</td>
<td>36.0</td>
<td>72.0</td>
</tr>
<tr>
<td>Exonuclease I at 20 units/μL</td>
<td>1.2</td>
<td>72.0</td>
<td>144.0</td>
</tr>
</tbody>
</table>

Total Volume 6.0 360.0 720.0

2 Add 6 μL of diluted Exo I at 4 U/μL to each 15 μL STA reaction, vortex, centrifuge and place in a thermal cycler.
3 Dilute the final products to an appropriate concentration for testing. The minimum amount of dilution that should be used is 5-fold but if the Ct (also known as Cq) values are consistently below 6 for some of the assays this may need to be increased to 10-fold or 20-fold. Use low EDTA TE or DNA Suspension Buffer (TEKnova, PN T0221) to dilute the products as shown below:

Table 6. Dilution Table

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>37 °C</td>
<td>30 min</td>
<td>Digest</td>
</tr>
<tr>
<td>80 °C</td>
<td>15 min</td>
<td>Inactivate</td>
</tr>
<tr>
<td>4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

4 Store diluted STA products at -20 °C or use immediately for on-chip PCR.

**NOTE** For larger volume STA reactions adjust the amounts of materials proportionally.

### Preparing the Sample Pre-Mix and Samples

The following protocol only specifies reagent prep for the 48.48 Dynamic Array™ IFC and the 96.96 Dynamic Array™ IFC.

When using a 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference (100-7222).

We recommend calculating overages when preparing the Sample Pre-Mix solution. The volumes in the table below apply to a Fluidigm 48.48 Dynamic Array IFC and a Fluidigm 96.96 Dynamic Array IFC.

1 Combine the following to make the Sample Pre-Mix solution:

Table 7. Sample Pre-Mix solutions

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume for 48.48 Dynamic Array IFC (μL)*</th>
<th>Volume for 96.96 Dynamic Array IFC (μL)†</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRE-MIX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2X SsoFast EvaGreen Supermix With Low ROX (Bio-Rad Laboratories, 172-5211)</td>
<td>2.5</td>
<td>3.0</td>
<td>180.0</td>
<td>360.0</td>
</tr>
<tr>
<td>20X DNA Binding Dye Sample Loading Reagent (100-3738)</td>
<td>0.25</td>
<td>0.3</td>
<td>18.0</td>
<td>36.0</td>
</tr>
<tr>
<td>STA and Exo I-treated sample</td>
<td>2.25</td>
<td>2.7</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>5</strong></td>
<td><strong>6</strong></td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

* 60 samples for ease of pipetting

† 120 samples for ease of pipetting
**IMPORTANT** Use caution when pipetting the Fluidigm 20X DNA Binding Dye Sample Loading Reagent as bubbles can be introduced.

2 In a 96-well plate, combine 3.3 μL of Sample Pre-Mix with 2.7 μL of STA and Exo I-treated sample to make a final volume of 6 μL Sample Mix solution.

3 Vortex the Sample Mix solution for a minimum of 20 seconds, and centrifuge for at least 30 seconds.

Prepared reactions can be stored at 4 °C overnight.

### Preparing the 5 μM (10X) Assay Mix

The following protocol only specifies reagent prep for the 48.48 Dynamic Array™ IFC and the 96.96 Dynamic Array™ IFC.

When using a 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference (100-7222).

The same preparation of primers can be used for the Fluidigm 48.48 Dynamic Array IFC and the Fluidigm 96.96 Dynamic Array IFC. Prepare primers as shown belown.

1 Combine the following:

   Table 8. Assay mix solutions

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume per 50 μL Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Assay Loading Reagent</td>
<td>2.5</td>
<td>3.0</td>
<td>25.0</td>
</tr>
<tr>
<td>1X DNA Suspension Buffer (Teknova, T0221)</td>
<td>2.25</td>
<td>2.7</td>
<td>22.5</td>
</tr>
<tr>
<td>100 μM each of Forward and Reverse Primer Mix</td>
<td>0.25</td>
<td>0.3</td>
<td>2.5</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>5.0</strong></td>
<td><strong>6.0</strong></td>
<td><strong>50.0</strong></td>
</tr>
</tbody>
</table>

2 Vortex the Assay Mix for a minimum of 20 seconds, and centrifuge for at least 30 seconds to spin down all components.

**IMPORTANT** Vortex thoroughly and centrifuge all sample and assay solutions before pipetting into the chip inlets. Failure to do so may result in a decrease in data quality.

**NOTE** The final concentration of each primer is 5 μM in the inlet and 500 nM in the final reaction.

### Priming the IFC and Loading Assay and Samples

For instructions on priming and loading the 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference (100-7222).

For detailed instructions for injecting control line fluid, see the Control Line Fluid Loading Procedure Quick Reference (68000132).
For detailed instructions about using Juno, see the Juno System User Guide (100-7070). For detailed instructions about using the IFC Controller MX, see the IFC Controller MX and IFC Controller HX User Guide (68000112).

**IMPORTANT** Due to different accumulator volumes, use the appropriate control line fluid syringe for the IFC type:
- For 48.48 IFCs, only use a syringe prefilled with 300 μL of control line fluid (89000020).
- For 96.96 IFCs, only use a syringe prefilled with 150 μL of control line fluid (89000021).

1. If using Juno, ensure that the MX Interface Plate (48.48 IFCs) or the HX Interface Plate (96.96 IFCs) is installed in the Juno instrument.

2. Inject control line fluid into each accumulator on the chip (see Figure 3).

3. Remove and discard the protective film from the bottom of the IFC.

4. Place the IFC into the controller:
   - Juno: Tap **OPEN** to open the instrument tray and align the notched corner of the IFC to the white notch on the tray. Tap **LOAD**.
   - MX or HX: Press **EJECT** to open the instrument tray and align the notched corner of the IFC to the A1 mark. Press **Load Chip**.

5. Run the Prime script:
   - Juno: Tap **Prime 48.48 GE** (48.48 IFCs) or **Prime 96.96 GE** (96.96 IFCs), then tap **Run**.
   - MX (48.48 IFCs): Select **Prime (113x)** and press **Run Script**.
   - HX (96.96 IFCs): Select **Prime (136x)** and press **Run Script**.

**IMPORTANT** Load the IFC within 1 hr of completing the Prime script.
Load the IFC

**IMPORTANT** While pipetting, do not go past the first stop on the pipette. Doing so may introduce air bubbles into inlets.

Refer to Figure 4 when pipetting final sample and assay mixes into the IFC.

1. After the Prime script is finished, remove the primed IFC from the controller.
2. Pipet 5 μL of each sample mix into the respective sample inlets on the IFC.
3. Pipet 5 μL of each assay mix into the respective assay inlets on the IFC.
4. Place the IFC into the controller:
   - Juno: Tap OPEN to open the instrument tray and align the notched corner of the IFC to the white notch on the tray. Tap LOAD.
   - MX or HX: Press EJECT to open the instrument tray and align the notched corner of the IFC to the A1 mark. Press Load Chip.
5. Run the Load Mix script:
   - Juno: Tap Load Mix 48.48 GE (48.48 IFCs) or Load Mix 96.96 GE (96.96 IFCs), then tap Run.
   - MX (48.48 IFCs): Select Load Mix (113x) and press Run Script.
   - HX (96.96 IFCs): Select Load Mix (136x) and press Run Script.

**IMPORTANT** If necessary, turn on the Biomark HD or Biomark system (computer and instrument). For Biomark, also launch the Data Collection software, and turn on the lamp. The lamp takes 20 min to warm up.

![Figure 4. Pipetting maps for the 48.48 and 96.96 IFCs](image-url)
Thermal-Cycle and Collect Real-Time PCR Data

For detailed instructions about using the Data Collection software, see the Biomark HD Data Collection User Guide (100-2451) or Biomark/EP1 Data Collection User Guide (68000127).

1. Remove the loaded IFC from the controller.
2. Use clear tape to remove any dust particles or debris from the IFC surface if necessary.
3. If necessary, double-click the Data Collection icon ( ) on the desktop of the Biomark HD computer to launch the software.
4. Click Start a New Run.
5. Confirm that the camera status indicator at the bottom of the window is green.
6. Place the loaded IFC on the instrument tray and align the notched A1 corner on the IFC with the A1 label on the tray. In the Data Collection software, click Load.
7. Confirm the IFC barcode and IFC type and then click Next.
8. Complete the Chip Run section by selecting either a new or a pre-defined run.

NOTE: To pre-define a run, see the Biomark HD Data Collection User Guide.

9. Complete the Chip Run Name and Location section:
   a. Enter a run name or select the checkbox to use the IFC barcode as the run name.
   b. Select a file storage location for a new IFC run and click Next.
10. Complete the Application, Reference and Probes section and then click Next.

<table>
<thead>
<tr>
<th>For</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Gene Expression</td>
</tr>
<tr>
<td>Passive reference</td>
<td>ROX™</td>
</tr>
<tr>
<td>Assay</td>
<td>Single probe</td>
</tr>
<tr>
<td>Probes</td>
<td>EvaGreen</td>
</tr>
</tbody>
</table>

11. Browse to and select the thermal protocol:

<table>
<thead>
<tr>
<th>For</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark HD</td>
<td></td>
</tr>
<tr>
<td>• 48.48 IFC</td>
<td>GE Fast 48x48 PCR+Melt v2.pcl</td>
</tr>
<tr>
<td>• 96.96 IFC</td>
<td>GE Fast 96x96 PCR+Melt v2.pcl</td>
</tr>
<tr>
<td>Biomark</td>
<td></td>
</tr>
<tr>
<td>• 48.48 IFC</td>
<td>GE 48x48 PCR+Melt v2.pcl</td>
</tr>
<tr>
<td>• 96.96 IFC</td>
<td>GE 96x96 PCR+Melt v2.pcl</td>
</tr>
</tbody>
</table>

NOTE: For a description of the thermal protocols, see page 148.

12. Confirm that Auto Exposure is selected. Click Next.
13. Confirm that IFC run information is correct and click Start Run.
14. After the run is complete, analyze your data using the Real-Time PCR Analysis software.
Using the Real-Time PCR Analysis Parameters

1. Double-click the **Real-Time PCR Analysis** icon on the desktop to launch the Real-Time PCR Analysis software.

2. Click **Open**, then browse to and select the chiprun.bml file to open it in the Real-Time PCR Analysis software.

3. Enter the detector and sample information.

4. Click **Details Views**. We recommend using the following Analysis Settings,.

<table>
<thead>
<tr>
<th>For</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline Correction</td>
<td>Linear Derivative</td>
</tr>
<tr>
<td>Ct Threshold Method</td>
<td>Auto (Global)</td>
</tr>
</tbody>
</table>

   **NOTE** For more information about baseline correction methods, contact Fluidigm Technical Support.

5. Always compare the Tm of the intended products to a positive control sample.

6. Click **Analyze** to analyze the IFC run.

Thermal Cycler Protocols

Fast Protocols

**GE Fast 48x48 PCR+Melt v2 thermal cycling parameters (for Biomark HD only)**

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td>60–95 °C</td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>

**GE Fast 96x96 PCR+Melt v2 thermal cycling parameters (for Biomark HD only)**

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C</td>
<td>2400 sec</td>
<td>Thermal mix</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>30 sec</td>
<td>Hot start</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>PCR: 30 cycles</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td>60–95 °C</td>
<td>1 °C/3 sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Standard Protocols

### GE 48x48 PCR+Melt v2 thermal cycling parameters

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>3 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>

### GE 96x96 PCR+Melt v2 thermal cycling parameters

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C</td>
<td>2400 sec</td>
<td>Thermal mix</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>30 sec</td>
<td></td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>95 °C</td>
<td>60 sec</td>
<td>Hot start</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>60 °C</td>
<td>3 sec</td>
<td>Melting curve</td>
<td>1 °C/sec</td>
</tr>
<tr>
<td>60–95 °C</td>
<td></td>
<td></td>
<td>1 °C/3 sec</td>
</tr>
</tbody>
</table>
Appendix D: Fast Gene Expression Analysis Using TaqMan Gene Expression Assays on the Biomark HD System

This protocol is intended to be used for fast gene expression analysis on the Biomark™ HD System using TaqMan® Gene Expression Assays. The protocol is suitable for use with either 48.48 or 96.96 Dynamic Array™ IFCs and appropriate cycling protocols are provided for each chip type. This protocol requires a Biomark™ HD System, which includes a thermal cycler with fast cycling capabilities. The protocol also requires the use of a master mix that does not require a long hot start and that works well with the shortened cycling times. Three master mixes that we have found to work well are Quanta PerfeCTa™ qPCR Fast Mix from Quanta Biosciences (also available from VWR), TaqMan Fast Universal Master Mix from Applied Biosystems, and TaqMan GTXpress Master Mix from Applied Biosystems. In preliminary testing, the new TaqMan Fast Advanced Master Mix from Applied Biosystems also appears to be suitable for use with this protocol. Although the four master mixes above are recommended because they work well for fast gene expression analysis, they also can be used with standard cycling conditions.

This protocol was thoroughly tested on a wide variety of assays and good results can be expected from the majority of assays. For especially difficult assays, the cycling conditions can be modified.
# Materials

## Required Reagents

**IMPORTANT** Store reagents as soon as they are received, according to manufacturer’s storage recommendations.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X GE Sample Loading Reagent</td>
<td>Fluidigm</td>
<td>85000735 (250 μL) 85000746 (1 mL)</td>
</tr>
<tr>
<td>2X Assay Loading Reagent</td>
<td></td>
<td>85000736</td>
</tr>
<tr>
<td>PreAmp Master Mix</td>
<td></td>
<td>100-5580 (1 tube, 106 μL/tube)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>100-5581 (5 tubes, 106 μL/tube)</td>
</tr>
<tr>
<td>2X Master Mix for Fast Cycling:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Quanta PerfeCTa® qPCR Fast Mix®, low ROX®</td>
<td>Quanta Biosciences</td>
<td>95078-012</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VWR 101419-220</td>
</tr>
<tr>
<td>• TaqMan Fast Universal PCR Master Mix</td>
<td>Thermo Fisher Scientific</td>
<td>4352042</td>
</tr>
<tr>
<td>• TaqMan GTXpress Master Mix</td>
<td>Thermo Fisher Scientific</td>
<td>4401892</td>
</tr>
<tr>
<td>• TaqMan Fast Advanced Master Mix</td>
<td>Thermo Fisher Scientific</td>
<td>4444557</td>
</tr>
<tr>
<td>20X TaqMan Gene Expression Assays</td>
<td>Thermo Fisher Scientific</td>
<td>—</td>
</tr>
</tbody>
</table>

## Required Consumables

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear adhesive film</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>96-well PCR plates</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Microcentrifuge tubes, 1.5 mL</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>8-well PCR tube strips</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
Appendix D: Fast Gene Expression Analysis Using TaqMan Gene Expression Assays on the Biomark HD System

Materials

Required Equipment

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark™ HD system</td>
<td>Fluidigm</td>
<td>BMKHD-BMKHD</td>
</tr>
<tr>
<td>Juno™ system or IFC Controller MX (48.48 Dynamic Array IFCs) or IFC Controller HX (96.96 Dynamic Array IFCs) or IFC Controller RX (192.24 Dynamic Array IFCs)</td>
<td>Fluidigm</td>
<td>101-6455 or IFC-MX or IFC-HX or IFC-RX</td>
</tr>
<tr>
<td>If using Juno: MX Interface Plate (48.48 Dynamic Array IFCs) or HX Interface Plate (96.96 Dynamic Array IFCs) or RX Interface Plate (192.24 Dynamic Array IFCs)</td>
<td>Fluidigm</td>
<td>101-6115 or 101-6116 or 101-6114</td>
</tr>
<tr>
<td>2 centrifuges: 1 for microtubes, 1 for 96-well PCR plates</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Pipettes (P2–P1000) and appropriate filtered, low-retention tips</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>8-channel pipettes and appropriate filtered, low-retention tips</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Vortexer</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Thermal cycler for 96-well plates</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
</tbody>
</table>

Software Requirements

The following software is required for this protocol:

- Fluidigm® Real-Time PCR Analysis Software v.3.0.2 or later
- Biomark™ HD Data Collection Software v.3.0.2 or later
Gene Expression PreAmp with Fluidigm PreAmp Master Mix and TaqMan Assays

In the Biomark HD System, samples are loaded into individual inlets and then distributed across multiple reaction chambers in nanoliter volume aliquots. With these small volumes, detecting the specific targets requires a minimum of 800 copies/μL in the final sample mix. For genes with lower expression levels, there are too few copies to detect adequately in cDNA samples. Preamplification is used to increase the number of copies to a detectable level for a greater number of genes.

Preamplification allows for multiplex amplification of up to 96 targets. A pool of primers is prepared from the same gene expression assays to be used for qPCR. By using the real-time qPCR assays in the preamplification reaction, only the targets of interest are amplified. A limited number of cycles is used, generally 10-14. Under these conditions of low primer concentration and a limited number of cycles, the cDNA is amplified without significant bias for the majority of genes.

Pooling the TaqMan Gene Expression Assays

1. In a microcentrifuge tube, combine equal volumes of each 20x TaqMan gene expression assay, up to a total of 96 assays.

2. Dilute the pooled assays using DNA Suspension Buffer (10 mM Tris, pH 8.0, 0.1 mM EDTA; TEKnova, PN T0221) so that each assay is at a final concentration of 0.2x (180 nM).

3. The chart below provides an example using 96 assays:

<table>
<thead>
<tr>
<th>96 Assays</th>
<th>DNA Suspension Buffer</th>
<th>Total Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 μL each assay (20x)</td>
<td>8 μL</td>
<td>200 μL</td>
</tr>
</tbody>
</table>

   **NOTE** Volume can be adjusted proportionally based on the number of samples to be amplified.

Preparing Sample Pre-Mix and Samples

1. In a DNA-free hood, prepare a Pre-Mix for the reactions as indicated in the table below:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume / Reaction (μL)</th>
<th>Volume for 48 Reactions + 10% Overage (μL)</th>
<th>Volume for 96 Reactions + 10% Overage (μL)</th>
<th>Volume for 192 Reactions + 10% Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRE-MIX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PreAmp Master Mix</td>
<td>1.00</td>
<td>52.8</td>
<td>105.6</td>
<td>211.2</td>
</tr>
<tr>
<td>Pooled TaqMan assay mix (0.2x)</td>
<td>1.25</td>
<td>66.0</td>
<td>132.0</td>
<td>264.0</td>
</tr>
<tr>
<td>Water</td>
<td>1.50</td>
<td>79.2</td>
<td>158.4</td>
<td>316.8</td>
</tr>
<tr>
<td>cDNA</td>
<td>1.25</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Total Volume</td>
<td>5.00</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
2 In a PCR plate, aliquot 3.75 μL of Pre-Mix for each sample.

3 Remove the plate from the DNA-free hood and add 1.25 μL of cDNA to each well containing Pre-Mix, making a total volume of 5 μL.

4 Mix the reactions by briefly vortexing, then centrifuge.

**Thermal Cycling**

1 Place the plate in the thermal cycler and cycle using the following table as a guide:

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>2 min</td>
<td>Hold</td>
</tr>
<tr>
<td>95 °C</td>
<td>15 sec</td>
<td>14 cycles Denaturation Annealing/Extension</td>
</tr>
<tr>
<td>60 °C</td>
<td>4 min</td>
<td>Hold</td>
</tr>
<tr>
<td>4 °C</td>
<td>∞</td>
<td>Hold</td>
</tr>
</tbody>
</table>

2 After cycling, dilute the reaction 1:5 by adding 20 μL TE Buffer (10 mM Tris-HCl, 1.0 mM EDTA, TEKnova, PN T0221) to the final 5 μL reaction volume for a total volume of 25 μL.

**NOTE** Fourteen (14) cycles are recommended as a starting point, but this can be decreased down to 10 cycles or increased up to 20 cycles, if necessary. The appropriate number of cycles should be determined empirically.

**NOTE** Diluted reaction products can either be assayed immediately or stored at -20 °C for later use. Diluted reaction products should be stable for at least one week.

**Preparing 10X Assays**

The following protocol only specifies reagent prep for the 48.48 Dynamic Array™ IFC and the 96.96 Dynamic Array™ IFC.

- When using a Flex Six™ Gene Expression IFC, refer to the Gene Expression with the Flex Six IFC Using Fast/Standard TaqMan Assays Quick Reference (100-7251).

- When using a 192.24 Gene Expression IFC, refer to the Gene Expression with the 192.24 IFC Using Standard TaqMan Assays Quick Reference (100-6170) or the Gene Expression with the 192.24 IFC Using Fast TaqMan Assays (Biomark HD only) Quick Reference (100-6174).

In a DNA-free hood, prepare aliquots of 10X assays using volumes in the table below (scale up appropriately for multiple runs).

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume per 50 μL Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X TaqMan Gene Expression Assay (Thermo Fisher Scientific)</td>
<td>2.5</td>
<td>3.0</td>
<td>25.0</td>
</tr>
<tr>
<td>2X Assay Loading Reagent</td>
<td>2.5</td>
<td>3.0</td>
<td>25.0</td>
</tr>
<tr>
<td>Total Volume</td>
<td>5.0</td>
<td>6.0</td>
<td>50.0</td>
</tr>
</tbody>
</table>

Final Concentration at 10X

- Primers: 9 μM
- Probe: 2.5 μM
Preparing Sample Pre-Mix and Samples

1 Prepare a Sample Pre-Mix solution containing the Master Mix and 20X GE Sample Loading Reagent sufficient for the number and type of chips to be run.

The following table provides the component amounts for one 48.48 or one 96.96 chip.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Sample Pre-Mix for 48.48 (μL)†</th>
<th>Sample Pre-Mix for 96.96 (μL)‡</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Master Mix*</td>
<td>2.5</td>
<td>3.0</td>
<td>180.0</td>
<td>360.0</td>
</tr>
<tr>
<td>20X GE Sample Loading Reagent (85000735, 85000746)</td>
<td>0.25</td>
<td>0.3</td>
<td>18.0</td>
<td>36.0</td>
</tr>
<tr>
<td>cDNA</td>
<td>2.25</td>
<td>2.7</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>5.0</strong></td>
<td><strong>6.0</strong></td>
<td><strong>—</strong></td>
<td><strong>—</strong></td>
</tr>
</tbody>
</table>

* Quanta PerfeCTa® qPCR Fast Mix®, low ROX® (Quanta BioSciences, PN 95078-012 or VWR, PN 101419-220) or TaqMan Fast Universal PCR Master Mix (Applied Biosystems, PN 4352042) or TaqMan GTXpress Master Mix (Applied Biosystems, PN 4401892) or TaqMan Fast Advanced Master Mix (Applied Biosystems, PN 4444557)

† 60 reactions for ease of pipetting
‡ 120 reactions for ease of pipetting

These volumes include some overage to account for pipetting error.

2 In a DNA-free hood, combine the two Sample Pre-Mix components in a 1.5 mL sterile tube—enough volume to fill an entire chip. Aliquot 3.3 μL of the Sample Pre-Mix for each sample.

3 Remove the aliquots from the DNA-free hood and add 2.7 μL of cDNA to each, to make a total volume of 6 μL in each aliquot.

** Priming and Loading the Dynamic Array IFC**

- For instructions on priming and loading the 48.48 Dynamic Array IFC, see Gene Expression with the 48.48 IFC Using Fast TaqMan Assays (Biomark HD Only) Quick Reference (100-2637).
- For instructions on priming and loading the 96.96 Dynamic Array IFC, see the Gene Expression with the 96.96 IFC Using Standard TaqMan Assays Quick Reference (68000130).
- For instructions on priming and loading the Flex Six™ Gene Expression IFC, see the Gene Expression with the Flex Six IFC Using Fast/Standard TaqMan Assays Quick Reference (100-7251).
- For instructions on priming and loading the 192.24 Gene Expression IFC, see the Gene Expression with the 192.24 IFC Using Standard TaqMan Assays Quick Reference (100-6170) or the Gene Expression with the 192.24 IFC Using Fast TaqMan Assays (Biomark HD only) Quick Reference (100-6174).
Using the Data Collection Software

The protocols used for data collection are fast protocols.

For 48.48 Dynamic Array IFCs

Select GE 48X48 Fast v1.pcl in the GE folder.

This cycling protocol is 95°C for 1 minute, followed by 35 cycles of 96°C for 5 seconds and 60°C for 20 seconds. This protocol takes approximately 26 minutes.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>1 min</td>
<td>Hot Start (Taq Activation)</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>Amplification: 35 cycles</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td>Annealing/Extension</td>
</tr>
</tbody>
</table>

For 96.96 Dynamic Array IFCs

Select GE 96x96 Fast v2.pcl in the GE folder.

The cycling protocol portion includes the Thermal Mix protocol for the 96.96 Dynamic Array IFC. The total program runs approximately 66 minutes. The complete program is as follows: 70°C for 40 minutes, 60°C for 30 seconds, 98°C for 1 minute, followed by 35 cycles of 97°C for 5 seconds and 60°C for 20 seconds.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Cycles</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C</td>
<td>40 min</td>
<td>1</td>
<td>Thermal Mix</td>
<td>Fast 5.5°C/s</td>
</tr>
<tr>
<td>60 °C</td>
<td>30 sec</td>
<td>1</td>
<td>Hot Start</td>
<td></td>
</tr>
<tr>
<td>98 °C</td>
<td>1 min</td>
<td>1</td>
<td>Denaturation</td>
<td></td>
</tr>
<tr>
<td>97 °C</td>
<td>5 sec</td>
<td>35</td>
<td>Annealing</td>
<td></td>
</tr>
</tbody>
</table>

Using UNG for Preventing Carryover Contamination

The Quanta PerfeCTa qPCR Fast Mix and the TaqMan Fast Advanced Master Mix both contain UNG. If using these master mixes, the cycling program can be modified to include a UNG step to protect against carryover contamination. Note the following:

- For the Quanta PerfeCTa qPCR Fast Mix, a 2-minute incubation at 45°C is recommended by the manufacturer. For the 48.48 Dynamic Array IFC, this should be added at the beginning of the program. For the 96.96 Dynamic Array IFC, this should be added before the Hot Mix step.

- For the TaqMan Fast Advanced Master Mix, a 2-minute incubation at 50°C is recommended. This should be added at the beginning of the program for the 48.48 Dynamic Array IFC and before the Hot Mix step for the 96.96 Dynamic Array IFC.

The TaqMan Fast Universal PCR Master Mix contains dUTP and can be modified by the addition of UNG. The TaqMan GTXpress Master Mix was designed for genotyping applications and does not contain any dUTP.
Appendix E: Single-Cell Fast TaqMan Gene Expression Real-Time PCR Using Dynamic Array IFCs on Biomark HD

This protocol is intended to be used for fast gene expression analysis of single cells using TaqMan™ Gene Expression Assays on the Biomark™ HD System. The protocol includes three sections: 1) single cell sorting; 2) reverse transcription and specific target amplification (RT-STA); and 3) real-time PCR on either 48.48 or 96.96 Dynamic Array™ integrated fluidic circuits (IFCs). Individual cells are sorted by Fluorescence Activated Cell Sorting (FACS) into a 96-well PCR plate. RT-STA is carried out on a 96-well thermal cycler using the CellsDirect™ One-Step qRT-PCR kit and gene-specific primers included in the TaqMan assays. This reaction generates sufficient template cDNA for TaqMan real-time analysis on Dynamic Array IFCs of hundreds of genes from hundreds of single cells in parallel. Fast real-time PCR for gene expression analysis requires a Biomark™ HD System, which includes a thermal cycler with fast cycling capabilities. Quanta PerfeCTa™ qPCR Fast Mix from Quanta Biosciences (also available from VWR) is used in combination with TaqMan Gene Expression Assays from Life Technologies Corporation for real-time PCR analysis.

This protocol has been verified on both 48.48 and 96.96 Dynamic Array IFCs.

Materials

Required Reagents

IMPORTANT Store reagents as soon as they are received, according to manufacturer’s storage recommendations.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X GE Sample Loading Reagent</td>
<td>Fluidigm</td>
<td>85000735 (250 μL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>85000746 (1 mL)</td>
</tr>
<tr>
<td>2X Assay Loading Reagent</td>
<td></td>
<td>85000736</td>
</tr>
<tr>
<td>Quanta PerfeCTa qPCR Fast Mix, low ROX</td>
<td>Quanta Biosciences</td>
<td>95078-012</td>
</tr>
<tr>
<td></td>
<td>VWR</td>
<td>1014190-220</td>
</tr>
<tr>
<td>PCR certified water</td>
<td>TEKnova</td>
<td>W3330</td>
</tr>
<tr>
<td>DNA Suspension Buffer (10 mM Tris, pH 8.0, 0.1 mM EDTA)</td>
<td>TEKnova</td>
<td>T0221</td>
</tr>
<tr>
<td>20X TaqMan Gene Expression Assays</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>CellsDirect One-Step qRT-PCR Kit</td>
<td>Thermo Fisher Scientific</td>
<td>11753-100 (100 reactions)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11753-500 (500 reactions)</td>
</tr>
<tr>
<td>Ambion SUPERase-In</td>
<td></td>
<td>AM2694</td>
</tr>
</tbody>
</table>
Appendix E: Single-Cell Fast TaqMan Gene Expression Real-Time PCR Using Dynamic Array IFCs on Biomark HD
Materials

## Required Consumables

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp™ Optical Adhesive Film</td>
<td>Thermo Fisher Scientific</td>
<td>4311971</td>
</tr>
<tr>
<td>96-well PCR plates that are compatible with the FACS instrument and thermal cycler</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Microcentrifuge tubes, 1.5 mL</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>8-well PCR tube strips</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>

## Required Equipment

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark™ HD system</td>
<td></td>
<td>BMKHD-BMKHD</td>
</tr>
<tr>
<td>Juno™ system or IFC Controller MX (48.48 Dynamic Array IFCs) or IFC Controller HX (96.96 Dynamic Array IFCs)</td>
<td>Fluidigm</td>
<td>101-6455 or IFC-MX or IFC-HX</td>
</tr>
<tr>
<td>If using Juno: MX Interface Plate (48.48 Dynamic Array IFCs) or HX Interface Plate (96.96 Dynamic Array IFCs)</td>
<td></td>
<td>101-6115 or 101-6116</td>
</tr>
<tr>
<td>FACS instrument</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>2 centrifuges: 1 for microtubes, 1 for 96-well PCR plates</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>Pipettes (P2–P1000) and appropriate filtered, low-retention tips</td>
<td>Major laboratory supplier</td>
<td>—</td>
</tr>
<tr>
<td>8-channel pipettes and appropriate filtered, low-retention tips</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>Vortexer</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>Thermal cycler for 96-well plates</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>

## Software Requirements

The following software is required for this protocol:

- Fluidigm® Real-Time PCR Analysis Software v.3.0.2 or later
- Biomark™ HD Data Collection Software v.3.0.2 or later
Appendix E: Single-Cell Fast TaqMan Gene Expression Real-Time PCR Using Dynamic Array IFCs on Biomark HD

Cell Sorting Procedure

1. For each 96-well PCR plate, prepare 2X reaction reagent by mixing 580 μL of the CellsDirect 2X Reaction Mix with 11.6 μL of Ambion SUPERase-In.

2. Pipette 5.1 μL of the 2X reaction reagent into each well of the PCR plate and seal the plate with adhesive film. Store the plate on ice if cells are sorted within one day. Otherwise, store at -20°C.

3. Using a FACS instrument, sort cells of interest directly into the plate containing the 2X reaction reagent.

4. Seal plates with adhesive film, vortex for 10 seconds, and centrifuge at 1500 RPM for 1 minute.

5. Use immediately or store at -80°C.

NOTE
- The FACS instrument needs to be carefully calibrated to deposit single cells in the center of each well of the PCR plate.
- Sort in batch mode using a FACS machine.
- Sort cells into the same plate that will be used for thermal cycling.

Reverse Transcription-Specific Target Amplification (RT-STA)

This reverse transcription preamplification procedure works for both standard and fast TaqMan gene expression applications.

1. In a DNA-free hood, pool all TaqMan Gene Expression Assays and dilute with DNA Suspension Buffer so that each assay is at a final concentration of 0.2X. For example, pipette 4 μL of each of the 96 TaqMan Gene Expression Assays (384 μL total) into a 1.5 ml sterile tube and add 16 μL of DNA Suspension Buffer, resulting in 400 uL of 0.2X primer/probe mix.

2. For each 96-well PCR plate containing sorted cells, prepare the reaction mix by combining 300 μL of the 0.2X Primer/Probe mix, 24 μL of SuperScript III RT/Platinum® Taq Mix and 144 μL of PCR certified water into a 1.5 ml sterile tube. Vortex for 10 seconds.

Table 1. Reaction Mix

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Well (μL)</th>
<th>Volume per 96-well Plate with Overage (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2X Primer/Probe Mix</td>
<td>2.5</td>
<td>300.0</td>
</tr>
<tr>
<td>SuperScript™ III RT/Platinum® Taq Mix</td>
<td>0.2</td>
<td>24.0</td>
</tr>
<tr>
<td>PCR certified water</td>
<td>1.2</td>
<td>144.0</td>
</tr>
<tr>
<td>Total</td>
<td>3.9</td>
<td>468.0</td>
</tr>
</tbody>
</table>

3. To each tube of an 8-well PCR strip, add 50 μL of the reaction mix. Transfer 3.9 μL of the reaction mix to each well of the PCR plate containing cells from the strip using an 8-channel pipette, seal, vortex for 10 seconds and centrifuge at 1500 RPM for 1 minute.
Place the plate onto a 96-well thermal cycler and proceed to RT-STA using the thermal cycling protocol below.

**Table 2. Thermal cycle conditions**

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 °C</td>
<td>15 min</td>
<td>RT</td>
</tr>
<tr>
<td>95 °C</td>
<td>2 min</td>
<td>Taq Activation</td>
</tr>
<tr>
<td>95 °C</td>
<td>15 sec</td>
<td>STA: 18 cycles</td>
</tr>
<tr>
<td>60 °C</td>
<td>4 min</td>
<td>Annealing/Extension</td>
</tr>
</tbody>
</table>

Dilute the resulting cDNA product 1:5 with DNA Suspension Buffer.

**Preparing 10X Assays**

In a DNA-free hood, prepare aliquots of 10X assays using volumes in the table below (scale up appropriately for multiple runs).

**Table 3. Assay preparation**

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume per 50 μL Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X TaqMan Gene Expression Assay</td>
<td>2.5</td>
<td>3.0</td>
<td>25.0</td>
</tr>
<tr>
<td>(Thermo Fisher Scientific)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2X Assay Loading Reagent</td>
<td>2.5</td>
<td>3.0</td>
<td>25.0</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td>5.0</td>
<td>6.0</td>
<td>50.0</td>
</tr>
<tr>
<td>Final Concentration at 10X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primers: 9 μM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Probe: 2.5 μM</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Preparing Sample Pre-Mix and Samples**

Prepare a Sample Pre-Mix solution containing the Master Mix and 20X GE Sample Loading Reagent sufficient for the number and type of chips to be run.

1. The following table provides the component amounts for one (1) 48.48 or one (1) 96.96 chip.

**Table 4. Sample Pre-Mix and Samples**

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Sample Pre-Mix for 48.48 (μL)</th>
<th>Sample Pre-Mix for 96.96 (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Master Mix*</td>
<td>2.5</td>
<td>3.0</td>
<td>180</td>
<td>360</td>
</tr>
<tr>
<td>20X GE Sample Loading Reagent</td>
<td>0.25</td>
<td>0.3</td>
<td>18</td>
<td>36</td>
</tr>
<tr>
<td>Diluted RT-STA Sample</td>
<td>2.25</td>
<td>2.7</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>5.0</strong></td>
<td><strong>6.0</strong></td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

* Quanta PerfeCTa™ qPCR Fast Mix, low ROX (Quanta BioSciences, PN 95078-012 or VWR, PN 1014190-220)
These volumes include some overage to account for pipetting error.

1. In a DNA-free hood, combine the two Sample Pre-Mix components (A) and (B) from the table above in a 1.5 mL sterile tube--enough volume to fill an entire chip. Aliquot 3.3 μL of the Sample Pre-Mix for each sample to be analyzed in an empty 96-well PCR plate.

2. Remove the Sample Pre-Mix aliquots from the DNA-free hood and add 2.7 μL of the diluted RT-STA sample to each, to make a total volume of 6 μL, then seal, vortex for 10 seconds and centrifuge at 1500 RPM for 1 minute.

**Priming and Loading the Dynamic Array IFC**

For instructions on loading the 48.48 Dynamic Array IFC, see the Gene Expression with the 48.48 IFC Using Standard TaqMan Assays Quick Reference (68000089). For instructions on loading the 96.96 Dynamic Array IFC, see Gene Expression with the 96.96 IFC Using Standard TaqMan Assays Quick Reference (68000130).

**Using the Data Collection Software**

The protocols used for data collection are fast protocols.

**For 48.48 Dynamic Array IFCs**

Select **GE 48X48 Fast v1.pcl** in the GE folder.

This protocol takes approximately 26 minutes. This cycling protocol is described below:

Table 5. 48.48 protocol

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>95 °C</td>
<td>1 min</td>
<td>Hot Start (Taq Activation)</td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>Amplification: 35 cycles</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td>Denaturation</td>
</tr>
</tbody>
</table>

**For 96.96 Dynamic Array IFCs**

Select **GE 96x96 Fast v2.pcl** in the GE folder.

The cycling protocol includes the Thermal Mix protocol for the 96.96 Dynamic Array IFC. The total program runs approximately 66 minutes. The complete program is described below:

Table 6. 96.96 protocol

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Cycles</th>
<th>Description</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C</td>
<td>40 min</td>
<td>1</td>
<td>Thermal Mix</td>
<td>Fast 5.5°C/s</td>
</tr>
<tr>
<td>60 °C</td>
<td>30 sec</td>
<td>1</td>
<td>Hot Start</td>
<td></td>
</tr>
<tr>
<td>98 °C</td>
<td>1 min</td>
<td>1</td>
<td>Denaturation</td>
<td></td>
</tr>
<tr>
<td>97 °C</td>
<td>5 sec</td>
<td>35</td>
<td>Annealing</td>
<td></td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix F: Gene Expression with the Flex Six IFC

Overview of the Flex Six IFC

The Fluidigm® Flex Six™ Gene Expression IFC provides substantial flexibility in sample and assay numbers during target selection and genotyping while allowing complete use of the IFC. The six 12 X 12 partitions can be organized in any configuration in up to six separate experimental runs.

**NOTE** The chemistry (for example, EvaGreen or TaqMan) for an experimental run can differ from run to run. However, all partitions in use for a single experimental run must use the same chemistry.

- **Sequential Runs.** You can run any combination of experimental partitions sequentially. As a simple example, you can run a single partition, store the IFC, and then run additional partitions after storing the IFC again until all six partitions are used or until the IFC passes its 90-day expiration date:

- **Parallel Runs.** You can run experimental partitions in parallel. Each partition can contain an independent experiment, can be grouped together to form tiled experiments, or can be a mixture of both.
Components of the Flex Six IFC

Partitions and Inlets

- There are a total of six independent partitions in each Flex Six IFC (Figure 5).
- Each partition has a 12 X 12 format (12 assay and 12 sample inlets).
- Each partition can be run independently as a separate experimental run (at different times or on different days) or simultaneously (up to six partitions per run).

**IMPORTANT** At minimum, all 12 assay inlets and all 12 sample inlets for an active partition must be filled.

*Figure 5. Flex Six partitions and corresponding inlets*

The recommended volume of fluid in each inlet for the Flex Six Gene Expression IFC is 3 μL for assays and 3 μL for samples.
Barcodes

Each Flex Six IFC has a unique barcode. The first three digits of the barcode determine which applications are listed in the Applications menu in the software:

- **153x** – Flex Six Gene Expression (GE) IFC
- **154x** – Flex Six Genotyping (GT) IFC

**IMPORTANT** Do not combine GE and GT runs in the same IFC. Each IFC type is for a specific purpose.

Barrier Plugs

Barrier plugs allow tracking of which partitions are used and prevent pipetting into the wrong inlets. Do not discard the barrier plugs.

- Each plug is labeled according to its location (A for assay or S for sample, plus a number between 1 and 6).
- You can write on the plugs to denote which partitions have been used.
- Do not interchange the locations of the barrier plugs.
- During an experimental run, leave barrier plugs on the unused inlets of the IFC.
- When an IFC is being stored, ensure that there are barrier plugs on all unused inlets to eliminate dust or other contaminants in the inlets and to serve as visual aids for tracking partitions that can be used at a later date.
Configuring an Experiment

You can configure experiments in several ways.

**NOTE** The chemistry (for example, EvaGreen or TaqMan) for an experimental run can differ from run to run. However, all partitions in use for a single experimental run must use the same chemistry.

<table>
<thead>
<tr>
<th>Assays</th>
<th>Samples</th>
<th>Nr of Partitions</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>12</td>
<td>1</td>
<td>12 Assays X 12 Samples (One partition)</td>
</tr>
<tr>
<td>12</td>
<td>24</td>
<td>2</td>
<td>12 Assays X 24 Samples (Two partitions)</td>
</tr>
<tr>
<td>24</td>
<td>12</td>
<td>2</td>
<td>24 Assays X 12 Samples (Two partitions)</td>
</tr>
</tbody>
</table>

**NOTE** Scale up the amount of assays and samples appropriately.
Appendix F: Gene Expression with the Flex Six IFC

Materials

Required Reagents for Delta Gene Assays

IMPORTANT Store reagents as soon as they are received, according to manufacturer’s storage recommendations.

Reagents from Fluidigm

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Part Number</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Assay Loading Reagent</td>
<td>100-5359</td>
<td></td>
</tr>
<tr>
<td>PreAmp Master Mix</td>
<td>100-5580 (1 tube, 106 μL/tube)</td>
<td>-20 °C</td>
</tr>
<tr>
<td></td>
<td>100-5581 (5 tubes, 106 μL/tube)</td>
<td></td>
</tr>
<tr>
<td>Flex Six Delta Gene Sample Reagent (≤ 6 freeze/thaw cycles)</td>
<td>100-7673</td>
<td>-20 °C</td>
</tr>
<tr>
<td>Delta Gene™ Primers (Forward and Reverse combined; 100 μM each)</td>
<td>ASY-GE</td>
<td></td>
</tr>
<tr>
<td>Non wet-lab tested or Wet-lab tested</td>
<td>ASY-GE WET</td>
<td></td>
</tr>
</tbody>
</table>

Reagents from Other Suppliers

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SsoFast™ EvaGreen® Supermix with Low ROX (2X)</td>
<td>Bio-Rad Laboratories</td>
<td>172-5211</td>
</tr>
<tr>
<td>Exonuclease I</td>
<td>New England BioLabs</td>
<td>M0293L</td>
</tr>
<tr>
<td>DNA Suspension Buffer (10 mM Tris, pH 8.0, 0.1 mM EDTA)</td>
<td>Teknovia</td>
<td>T0221</td>
</tr>
<tr>
<td>PCR-Certified Water</td>
<td></td>
<td>W3330</td>
</tr>
<tr>
<td>cDNA</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>

Reagents for Preamp and Exo I-Treated Sample

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PreAmp Master Mix</td>
<td>Fluidigm</td>
<td>100-5580 (1 tube, 106 μL/tube)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>100-5581 (5 tubes, 106 μL/tube)</td>
</tr>
<tr>
<td>Delta Gene Assay Mix</td>
<td>Fluidigm</td>
<td>—</td>
</tr>
<tr>
<td>Exonuclease I</td>
<td>New England BioLabs</td>
<td>M0293L</td>
</tr>
</tbody>
</table>
### Required Reagents for TaqMan Assays

#### Reagents from Fluidigm

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Part Number</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X Assay Loading Reagent</td>
<td>100-5359</td>
<td>−20 °C</td>
</tr>
<tr>
<td>PreAmp Master Mix</td>
<td>100-5580 (1 tube, 106 μL/tube)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100-5581 (5 tubes, 106 μL/tube)</td>
<td></td>
</tr>
<tr>
<td>20X GE Sample Loading Reagent</td>
<td>100-6311</td>
<td></td>
</tr>
</tbody>
</table>

#### Reagents for TaqMan Assays

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR-Certified Water</td>
<td>Teknova</td>
<td>W3330</td>
</tr>
<tr>
<td>TaqMan Fast Advanced Master Mix (for fast thermal-cycling only)</td>
<td>Thermo Fisher Scientific</td>
<td>4444557</td>
</tr>
<tr>
<td>TaqMan® Gene Expression PCR Master Mix (2X) (for standard thermal-cycling only)</td>
<td></td>
<td>4369016</td>
</tr>
<tr>
<td>TaqMan Gene Expression Assays (20X)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Required Consumables

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Line Fluid Kit—96.96</td>
<td>Fluidigm</td>
<td>89000021</td>
</tr>
<tr>
<td>Clear adhesive film</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-well PCR plates</td>
<td>Major laboratory supplier</td>
<td></td>
</tr>
<tr>
<td>Microcentrifuge tubes, 1.5 mL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8-well PCR tube strips</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Required Equipment

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark™ HD system</td>
<td>Fluidigm</td>
<td>BMKHD-BMKHD</td>
</tr>
<tr>
<td>Juno™ system or IFC Controller HX (96.96 Dynamic Array IFCs)</td>
<td>Fluidigm</td>
<td>101-6455 or IFC-HX</td>
</tr>
<tr>
<td>HX Interface Plate, if using Juno</td>
<td></td>
<td>101-6116</td>
</tr>
<tr>
<td>2 centrifuges: 1 for microtubes, 1 for 96-well PCR plates</td>
<td>Major laboratory supplier</td>
<td></td>
</tr>
<tr>
<td>Pipettes (P2–P1000) and appropriate filtered, low-retention tips*</td>
<td>Major laboratory supplier</td>
<td></td>
</tr>
<tr>
<td>Vortexer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermal cycler for 96-well plates</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Recommended: Rainin® pipettes
Software Requirements

The following software is required for this protocol:

- Fluidigm® Real-Time PCR Analysis Software v4 or later
- Biomark™ Data Collection Software v4 or later
- IFC Controller HX
  - Firmware 52 or later
  - Software 2.5 or later
Prime the Flex Six IFC (first use only)

You only need to prime the IFC on the first run. On subsequent use, skip this section.

For detailed instructions about using Juno, see the Juno System User Guide (100-7070). For detailed instructions about using the IFC Controller HX, see the IFC Controller MX and IFC Controller HX User Guide (68000112).

**IMPORTANT** When injecting control line fluid:
- Use the Flex Six IFC within 3 months of opening the package.
- Do not remove the barrier plugs until you load the IFC.
- Only use 96.96 control line fluid syringes (89000021). Each syringe contains 150 μL of control line fluid.

1. If using Juno, ensure that the HX Interface Plate is installed in the Juno instrument.
2. Remove the control line fluid syringes (89000021) and the Flex Six™ IFC from the packaging.
   **IMPORTANT** Do not evacuate air from the syringes prior to injecting control line fluid (Step 5).
3. Actuate the check valves:
   a. Place the IFC on a flat surface.
   b. Use a syringe with the shipping cap in place to actuate the check valve in each accumulator with gentle pressure. Ensure that the poppet can move freely up and down:

   ![Actuating the check valve in the accumulators on the Flex Six IFC](image)

4. Hold the syringe firmly in one hand with tip facing up and away from the IFC and remove the shipping cap with the other hand.
5. Holding the IFC at a 45° angle, insert the syringe tip into the top accumulator.
   **IMPORTANT**
   - Avoid bending the syringe tip. Be careful when removing the syringe cap to prevent drips.
   - Avoid getting control line fluid on the exterior of the IFC or in the inlets because this makes the IFC unusable. If this occurs, use a new IFC.
6 Insert the syringe tip into one of the spaces between the arms of the “X” at the top of the valve and then press down gently to move the black O-ring to the side.

7 Use the syringe tip to press down gently on the black O-ring to move it. Visually confirm that the O-ring has moved.

8 Release the control line fluid:
   a Press the syringe plunger to release the control line fluid into the accumulator while maintaining the 45° angle to allow the fluid to flow away from the O-ring.
   b Slowly inject the control line fluid by pushing down on the syringe plunger. The control line fluid will flow into the accumulator through the open check valve. Use the entire contents of the syringe.
   c After fully depressing the plunger, wait approximately 5 sec before withdrawing the syringe.

9 Check to ensure that the O-ring returns to its normal position after the syringe is removed.

10 Repeat Steps 4–9 to inject control line fluid into the other accumulator.

11 Pull the protective film down and away from the bottom of the IFC. Discard the film.

12 Place the IFC into the controller:
   - Juno: Tap OPEN to open the instrument tray and align the notched corner of the IFC to the white notch on the tray. Tap LOAD.
   - HX: Press EJECT to open the instrument tray and align the notched corner of the IFC to the A1 mark. Press Load Chip.

13 Run the Prime script:
   - Juno: Tap Prime (153x), then tap Run.
   - HX: Select Prime (153x) and press Run Script.

**IMPORTANT** The Prime script takes approximately 15 min to run. Load the IFC within 1 hr of completing the Prime script.
Assay and Sample Preparation Using Delta Gene Assays

IMPORTANT If you are using TaqMan assays, skip this section and go to Assay and Sample Preparation Using TaqMan Assays on page 173.

Prepare 10X Assays (Delta Gene assays)

IMPORTANT Due to the small pipetting volumes necessary for preparing a single assay mix, preparing a 10X assay stock is recommended. Unused 10X Assays can be stored at –20 °C for up to three weeks.

NOTE When preparing for an experiment that uses more than one partition, scale up the amount of assays appropriately.

In a DNA-free hood, prepare aliquots of 10X assays using volumes in Table 9.

Table 7. 10X assays for EvaGreen Fast/Standard Gene Expression

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume per 40 μL Stock (μL)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 μM each Delta Gene Primers (Forward and Reverse combined; 100 μM each), non wet-lab tested (ASY-GE) or wet-lab tested (ASY-GE WET)</td>
<td>0.15</td>
<td>0.2</td>
<td>2.0</td>
</tr>
<tr>
<td>DNA Suspension Buffer</td>
<td>1.35</td>
<td>1.8</td>
<td>18.0</td>
</tr>
<tr>
<td>2X Assay Loading Reagent (100-5359)</td>
<td>1.5</td>
<td>2.0</td>
<td>20.0</td>
</tr>
<tr>
<td>Total Volume</td>
<td>3.0</td>
<td>4.0</td>
<td>40.0</td>
</tr>
</tbody>
</table>

* 10 replicates
Preparing Sample Pre-Mix and Samples (Delta Gene assays)

**IMPORTANT**
- Pipet with care! The Delta Gene Sample Reagent is extremely viscous. **DO NOT VORTEX the Delta Gene Sample Reagent by itself at its stock concentration.**
- Vortex thoroughly and centrifuge all assay and sample solutions **EXCEPT the Flex Six Delta Gene Sample Reagent.** You can thaw the Flex Six Delta Gene Sample Reagent a maximum of SIX times only.
- Failure to follow the above caution statements may result in a decrease in data quality.

**NOTE** When preparing for an experiment that uses more than one partition, scale up the amount of samples appropriately.

Combine components in Table 8 to make the Sample Pre-Mix and final Sample Mixture in a 96-well plate, tubes, or tube strips.

1. In a DNA-free hood, combine the Sample Pre-Mix components to make enough for your experiment (33 μL/partition). Aliquot 2.2 μL of the pre-mix for each sample.

2. Remove the aliquots from the DNA-free hood and add 1.8 μL of PreAmp and Exo I-treated sample to each, making a total volume of 4 μL in each aliquot. Vortex and spin down the final Sample Mixture.

Table 8. Sample Pre-Mix and Sample Mixture for EvaGreen Fast/Standard Gene Expression

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Sample Pre-Mix for 1 Partition (μL)†</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PRE-MIX</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SsoFast EvaGreen Supermix with Low ROX (2X) (Bio-Rad)</td>
<td>1.50</td>
<td>2.0</td>
<td>30.0</td>
</tr>
<tr>
<td>Flex Six™ Delta Gene™ Sample Reagent (100-7673)</td>
<td>0.15</td>
<td>0.2</td>
<td>3.0</td>
</tr>
<tr>
<td>PreAmp and Exo I-treated sample* (Added individually to Sample Pre-Mix)</td>
<td>1.35</td>
<td>1.8</td>
<td>—</td>
</tr>
</tbody>
</table>

**Total Volume** | 3.00 | 4.0 | — |

* For more information about PreAmp and Exonuclease I treatment, refer to the Gene Expression Preamplification with Fluidigm Preamp Master Mix and TaqMan Assays Quick Reference (100-5875).
† 15 reactions for ease of pipetting

3. Go to Load the Flex Six IFC on page 175.
Assay and Sample Preparation Using TaqMan Assays

IMPORTANT If you are using Delta Gene Assays, skip this section and go to Assay and Sample Preparation Using Delta Gene Assays on page 171.

Prepare 10X Assays (TaqMan assays)

NOTE
• When preparing for an experiment that uses more than one partition, scale up the amount of assays appropriately.
• If you prefer to prepare a 10X assay stock, unused 10X assays can be stored at -20 °C for up to three weeks.

In a DNA-free hood, prepare aliquots of 10X assays using volumes in Table 9 (scale up appropriately for multiple runs).

Table 9. 10X assays for TaqMan Fast/Standard Gene Expression

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Volume per 40 μL Stock (μL)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>20X TaqMan Gene Expression Assay (Thermo Fisher Scientific)</td>
<td>1.5</td>
<td>2.0</td>
<td>20.0</td>
</tr>
<tr>
<td>2X Assay Loading Reagent (100-5359)</td>
<td>1.5</td>
<td>2.0</td>
<td>20.0</td>
</tr>
<tr>
<td>Total Volume</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.0</td>
<td>4.0</td>
<td>40.0</td>
</tr>
</tbody>
</table>

* 10 replicates

Prepare Sample Pre-Mix and Samples (TaqMan assays)

NOTE When preparing for an experiment that uses more than one partition, scale up the amount of samples appropriately.

Combine components in Table 4 to make the Sample Pre-Mix and final Sample Mixture in a 96-well plate, tubes, or tube strips.

1 a DNA-free hood, combine the Sample Pre-Mix components to make enough for your experiment (33 μL/partition). Aliquot 2.2 μL of the pre-mix for each sample.

2 Remove the aliquots from the DNA-free hood and add 1.8 μL of preamplified cDNA to each, making a total volume of 4 μL in each aliquot.
Table 10. Sample Pre-Mix and Sample Mixture for TaqMan Fast/Standard Gene Expression

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Inlet (μL)</th>
<th>Volume per Inlet with Overage (μL)</th>
<th>Sample Pre-Mix for 1 Partition (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PRE-MIX</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master Mix</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For standard:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan Gene Expression Master Mix</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Thermo Fisher Scientific, 4369016)</td>
<td>1.50</td>
<td>2.0</td>
<td>30.0</td>
</tr>
<tr>
<td><strong>For fast:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan Fast Advanced Master Mix</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Thermo Fisher Scientific, 4444557)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20X GE Sample Loading Reagent (100-6311)</td>
<td>0.15</td>
<td>0.2</td>
<td>3.0</td>
</tr>
<tr>
<td>Preamplified cDNA *</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Added individually to Sample Pre-Mix)</td>
<td>1.35</td>
<td>1.8</td>
<td>—</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td>3.00</td>
<td>4.0</td>
<td>—</td>
</tr>
</tbody>
</table>

* For more information about PreAmp and Exonuclease I treatment, refer to the Gene Expression Preamplification with Fluidigm Preamp Master Mix and TaqMan Assays Quick Reference (100-5876)

† 15 reactions for ease of pipetting

Go to Load the Flex Six IFC on page 175.
Load the Flex Six IFC

IMPORTANT
• Vortex thoroughly and centrifuge all final sample and assay mixes before pipetting into the IFC inlets. Failure to do so may result in a decrease in data quality.
• While pipetting, do not go past the first stop on the pipette. Doing so may introduce air bubbles into inlets.

IMPORTANT
• At minimum, all 12 assay inlets and all 12 sample inlets for a partition must be filled.
  • For unused assay inlets in active partitions, prepare 2.0 μL of Assay Loading Reagent and 2.0 μL water per inlet.
  • For unused sample inlets in active partitions, prepare 2.2 μL of sample pre-mix and 1.8 μL water per inlet.

After assay reagents and samples are pipetted into the inlets, they are loaded into their respective partitions in the thermo-conductive frame during the Load Script step. The reactions occur in the partitions. All usage of partitions and inlets is tracked by the Data Collection software for use with all IFCs.

1 After the Prime script is finished, remove the primed IFC from the controller.

2 Confirm that the barrier plugs are placed on unused inlets to mitigate pipetting into the wrong wells and to track used/unused partitions.

3 Pipet one partition at a time by removing the barrier plugs for that particular partition.

4 Pipet 3 μL of each final sample mix into the respective sample inlets on the IFC.

5 Pipet 3 μL of each final assay mix into the respective assay inlets on the IFC.

IMPORTANT Do not replace the barrier plugs after pipetting.

6 Place the IFC into the controller:
  • Juno: Tap OPEN to open the instrument tray and align the notched corner of the IFC to the white notch on the tray. Tap LOAD.
  • HX: Press EJECT to open the instrument tray and align the notched corner of the IFC to the A1 mark. Press Load Chip.

7 Run the Load Mix script:
  • Juno: Tap Load Mix Flex Six GE, then tap Run.
  • HX: Select Load Mix (153x) and press Run Script.
8 When the Load Mix script is complete, collect data on the Biomark HD or Biomark system (see page 176).

**IMPORTANT**
- Do not replace the barrier plugs after pipetting.
- If necessary, turn on the Biomark HD or Biomark system (computer and instrument). For Biomark, also launch the Data Collection software, and turn on the lamp. The lamp takes 20 min to warm up.
- The Load Mix script takes approximately 50 min to run. Start the IFC run on Biomark HD or Biomark within 1 hr of completing the Load Mix script.

**Collect Data Using the Biomark HD or Biomark System**

For detailed instructions about using the Data Collection software, see the Biomark HD Data Collection User Guide (100-2451).

**Setting Up a Tracking File**

If this is the first time you are running a Flex Six IFC after installing the Data Collection software or after restarting the computer, you need to set up a tracking file. After the tracking file is set up initially, the software creates a directory and stores all Flex Six data in this location.

**NOTE**
- If the directory that contains the tracking files changes, the Data Collection software will no longer be able to track IFC usage.
- If you have multiple Biomark HD and/or Biomark systems, you should create the tracking file in a location that can be accessed by all the systems. Only store Flex Six usage tracking files this way; do not store IFC run data on a network.

1 On the Biomark Data Collection Start window, select **Tools > FLEXsix Usage Tracking**.

2 Click **New** to create a new tracking file, or you can select an existing tracking file by using the **Browse** button.

3 If you are creating a new tracking file, enter a name for the file and navigate to the desired storage location. The file is saved as a FLEXsix Usage Tracking (*.fut) file.

4 Click **Done**.
Thermal-Cycle and Collect Data

1. Remove the loaded Flex Six IFC from Juno or IFC Controller HX.
2. Use clear tape to remove any dust particles or debris from the IFC surface if necessary.
3. If necessary, double-click the Biomark Data Collection icon ( ) on the desktop of the Biomark HD or Biomark computer to launch the software.
4. Click Start a New Run.
5. Confirm that the camera status indicator at the bottom of the window is green.
6. Place the loaded IFC on the instrument tray and align the notched A1 corner on the IFC with the A1 label on the tray. In the Data Collection software, click Load.
7. Confirm the IFC barcode and IFC type and then click Next.
8. Complete the Chip Run section by selecting either a new or a pre-defined run.
   
   **NOTE** To pre-define a run, see the Biomark HD Data Collection User Guide (100-2451) or the Biomark/EP1 Data Collection User Guide (68000127).
9. Complete the arrays, chip run name, and file location section:
   a. Select the partitions that you want to run. Figure 8 shows partitions 1 and 2 selected for use for the IFC run.
   b. Enter a run name or select the checkbox to use the IFC barcode as the run name.
   c. Select a file storage location for a new IFC run or browse to select a pre-defined run file and click Next.

Figure 8. Selected partitions, IFC run name, and IFC run file location
10 Complete the Application, Reference and Probes section, then click Next.

<table>
<thead>
<tr>
<th>For</th>
<th>Select (for Delta Gene assays)</th>
<th>Select (for TaqMan assays)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Gene Expression</td>
<td>Gene Expression</td>
</tr>
<tr>
<td>Passive reference</td>
<td>ROX™</td>
<td>ROX</td>
</tr>
<tr>
<td>Assay</td>
<td>Single probe</td>
<td>Select the number of probes and probe types</td>
</tr>
<tr>
<td>Probes</td>
<td>EvaGreen</td>
<td></td>
</tr>
</tbody>
</table>

11 Browse to and select the thermal protocol:

<table>
<thead>
<tr>
<th>For</th>
<th>Select (for Delta Gene assays)</th>
<th>Select (for TaqMan assays)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark HD</td>
<td>GE FLEXsix Fast PCR+Melt v1</td>
<td>GE FLEXsix Fast v2</td>
</tr>
<tr>
<td>Biomark</td>
<td>GE FLEXsix PCR+Melt v1</td>
<td>GE FLEXsix Standard v1</td>
</tr>
</tbody>
</table>

**NOTE**
- For a description of the thermal protocols for Delta Gene assays, see page 179.
- For a description of the thermal protocols for TaqMan assays, see page 180.

12 Confirm that Auto Exposure is selected. Click Next.

13 Confirm that the IFC run information is correct and click Start Run.

14 After the run is complete, analyze your data using the Real-Time PCR Analysis software.

**IMPORTANT** Immediately after the IFC run, transfer the IFC to the controller and run the Post Run script to relax the valves.

**Post IFC Run**

The Flex Six IFC requires a post run process to ensure the 90-day life time. Run the 5-min Post Run script immediately after the Biomark HD or Biomark system run, prior to any storage of the IFC.

1 Click Eject and remove the IFC from the Biomark HD or Biomark instrument.

2 Place the IFC back into the controller, then run the Post Run script:
   - Juno: Tap Post Run Flex Six GE, then tap Run.
   - HX: Select Post Run (153x) and press Run Script.

   **NOTE** The Post Run script takes approximately 5 min to run.

3 After the Post Run script is finished, remove the IFC from the controller.

4 Label the used barrier plugs and insert them into the used inlets.

5 Store the IFC at room temperature and protect it from dust until the next use.

**IMPORTANT**
- Use the entire IFC within 90 days of first use.
- After storage, you can load any unused partitions without the need to re-prime the used IFC.
NOTE

- The IFC can be stored at room temperature on the bench top or in a drawer. It is not necessary to store the IFC in the dark, inside the silver wrapper, or inside the box.
- Lay the IFC flat with inlets facing up when storing. Do not store the IFC on its side or upside-down.
- After a run, put the barrier plugs back into the used inlets. Label used barrier plugs so that you have a record of which partitions/inlets have been used.
- Between runs, ensure that the barrier plugs are in their proper positions for all unused partitions and that the IFC remains free of dust.

**Thermal Cycler Protocols for Delta Gene Assays**

**Fast thermal cycling parameters: GE FLEXsix Fast PCR+Melt v1 (for Biomark HD only)**

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Type</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 °C</td>
<td>30 min</td>
<td>Thermal Mix</td>
<td>5.5 °C/sec(fast)</td>
</tr>
<tr>
<td>70 °C</td>
<td>60 min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>95 °C</td>
<td>1 min</td>
<td>Hot Start</td>
<td></td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>Denaturation</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>Annealing</td>
</tr>
<tr>
<td>60–95 °C</td>
<td>3 sec</td>
<td>Melting</td>
<td>1 °C/sec (slow)</td>
</tr>
<tr>
<td></td>
<td>1 °C/sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Standard thermal cycling parameters: GE FLEXsix PCR+Melt v1**

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Type</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 °C</td>
<td>30 min</td>
<td>Thermal Mix</td>
<td>2 °C/sec (normal)</td>
</tr>
<tr>
<td>70 °C</td>
<td>60 min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>95 °C</td>
<td>1 min</td>
<td>Hot start</td>
<td></td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 30 cycles</td>
<td>Denaturation</td>
</tr>
<tr>
<td>60 °C</td>
<td>20 sec</td>
<td></td>
<td>Annealing</td>
</tr>
<tr>
<td>60–95 °C</td>
<td>3 sec</td>
<td>Melting</td>
<td>1 °C/sec (slow)</td>
</tr>
<tr>
<td></td>
<td>1 °C/sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Thermal Cycler Protocols for TaqMan Assays

### Fast thermal cycling parameters: GE FLEXsix Fast v2 (for Biomark HD only)

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Type</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 °C</td>
<td>30 min</td>
<td>Thermal Mix</td>
<td>5.5 °C/sec</td>
</tr>
<tr>
<td>70 °C</td>
<td>60 min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50 °C</td>
<td>2 min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>95 °C</td>
<td>1 min</td>
<td>Hot Start</td>
<td></td>
</tr>
<tr>
<td>96 °C</td>
<td>5 sec</td>
<td>PCR: 35 cycles</td>
<td></td>
</tr>
<tr>
<td>60 °C</td>
<td>20 s</td>
<td>Denaturation</td>
<td></td>
</tr>
</tbody>
</table>

### Standard thermal cycling parameters: GE FLEXsix Standard v1

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time</th>
<th>Type</th>
<th>Ramp Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 °C</td>
<td>30 min</td>
<td>Thermal Mix</td>
<td>2 °C/sec</td>
</tr>
<tr>
<td>70 °C</td>
<td>60 min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50 °C</td>
<td>2 min</td>
<td>UNG and hot start</td>
<td></td>
</tr>
<tr>
<td>95 °C</td>
<td>10 min</td>
<td>Hot Start</td>
<td></td>
</tr>
<tr>
<td>95 °C</td>
<td>15 sec</td>
<td>PCR: 40 cycles</td>
<td></td>
</tr>
<tr>
<td>60 °C</td>
<td>1 min</td>
<td>Denaturation</td>
<td></td>
</tr>
</tbody>
</table>

Annealing
Appendix G: Related Documents

Go to fluidigm.com to download these related documents.

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomark HD Data Collection User Guide</td>
<td>100-2451</td>
</tr>
<tr>
<td>Biomark/EP1 Data Collection User Guide</td>
<td>68000127</td>
</tr>
<tr>
<td>Juno System User Guide</td>
<td>100-7070</td>
</tr>
<tr>
<td>IFC Controller MX and IFC Controller HX User Guide</td>
<td>68000112</td>
</tr>
<tr>
<td>IFC Controller RX User Guide</td>
<td>100-3385</td>
</tr>
<tr>
<td>Fluidigm® IFC Controller Setup Guide</td>
<td>6800117</td>
</tr>
<tr>
<td>Fluidigm® IFC Controller Usage Quick Reference</td>
<td>68000126</td>
</tr>
<tr>
<td>Control Line Fluid Loading Procedure</td>
<td>68000132</td>
</tr>
<tr>
<td>Gene Expression Analysis with the GE 24.192 IFC Using TaqMan Assays Quick Reference</td>
<td>101-7916</td>
</tr>
<tr>
<td>Gene Expression with the 48.48 IFC Using Delta Gene Assays on Preamplified Samples Quick Reference</td>
<td>100-9791</td>
</tr>
<tr>
<td>Gene Expression with the 48.48 IFC Using Fast TaqMan Assays (Biomark HD Only) Quick Reference</td>
<td>100-2637</td>
</tr>
<tr>
<td>Gene Expression with the 48.48 IFC Using Standard TaqMan Assays Quick Reference</td>
<td>68000089</td>
</tr>
<tr>
<td>Gene Expression with the 96.96 IFC Using Delta Gene Assays on Preamplified Samples Quick Reference</td>
<td>100-9792</td>
</tr>
<tr>
<td>Gene Expression with the 96.96 IFC Using Fast TaqMan Assays (Biomark HD Only) Quick Reference</td>
<td>100-2638</td>
</tr>
<tr>
<td>Gene Expression with the 96.96 IFC Using Standard TaqMan Assays Quick Reference</td>
<td>68000130</td>
</tr>
<tr>
<td>Gene Expression with the 192.24 IFC Using Delta Gene Assays Quick Reference</td>
<td>100-7222</td>
</tr>
<tr>
<td>Gene Expression with the 192.24 IFC Using Standard TaqMan Assays Quick Reference</td>
<td>100-6170</td>
</tr>
<tr>
<td>Gene Expression with the 192.24 IFC Using Fast TaqMan Assays (Biomark HD only) Quick Reference</td>
<td>100-6174</td>
</tr>
<tr>
<td>Gene Expression with the Flex Six IFC Using Delta Gene Assays Quick Reference</td>
<td>100-7717</td>
</tr>
<tr>
<td>Gene Expression with the Flex Six IFC Using Fast/Standard TaqMan Assays Quick Reference</td>
<td>100-7251</td>
</tr>
<tr>
<td>Gene Expression STA with TaqMan Master Mix and TaqMan Assays Quick Reference</td>
<td>68000133</td>
</tr>
<tr>
<td>cDNA Preparation with Reverse Transcription Master Mix Quick Reference</td>
<td>100-6472</td>
</tr>
<tr>
<td>Preamplification of cDNA for Gene Expression with Delta Gene Assays Quick Reference</td>
<td>100-5875</td>
</tr>
<tr>
<td>Gene Expression Preamplification with Fluidigm Preamp Master Mix and TaqMan Assays Quick Reference</td>
<td>100-5876</td>
</tr>
</tbody>
</table>
Appendix H: Safety

General Safety
In addition to your site-specific safety requirements, Fluidigm recommends the following general safety guidelines in all laboratory and manufacturing areas:

- Use the appropriate personal protective equipment (PPE): safety glasses, fully enclosed shoes, lab coats, and gloves, according to your laboratory safety practices.
- Know the locations of all safety equipment (fire extinguishers, spill kits, eyewashes/showers, first-aid kits, safety data sheets, etc.), emergency exit locations, and emergency/injury reporting procedures.
- Do not eat, drink, or smoke in lab areas.
- Maintain clean work areas.
- Wash hands before leaving the lab.

Instrument Safety
For complete instrument safety information, including a full list of the symbols on the instrument, see the Juno System User Guide (100-7070), IFC Controller MX and IFC Controller HX User Guide (68000112), or IFC Controller RX User Guide (100-3385) and the Biomark HD Data Collection User Guide (100-2451) or Biomark/EP1 Data Collection User Guide (68000127).

**WARNING** BIOHAZARD. If you are putting biohazardous material on the instrument, use appropriate personal protective equipment and adhere to Biosafety in Microbiological and Biomedical Laboratories (BMBL), a publication from the Centers for Disease Control and Prevention, and to your lab’s safety protocol to limit biohazard risks. If biohazardous materials are used, properly label the equipment as a biohazard. For more information, see the BMBL guidelines online at cdc.gov/biosafety/publications/index.htm.

Chemical Safety
The responsible individuals must take the necessary precautions to ensure that the surrounding workplace is safe and that instrument operators are not exposed to hazardous levels of toxic substances. When working with any chemicals, refer to the applicable safety data sheets (SDSs) provided by the manufacturer or supplier.

Disposal of Products
Used IFCs and reagents should be handled and disposed of in accordance with federal, state, regional, and local laws for hazardous waste management and disposal.